INFORS AG LICENSE AGREEMENT

This is a legal agreement between you, the end user, and Infors AG.

SOFTWARE LICENSE

1. GRANT OF LICENSE
Infors AG grants to you the right to use one copy of the enclosed software program (the "SOFTWARE") on a single terminal connected to a single computer (i.e., with a single CPU). You may not network the SOFTWARE or otherwise use it on more than one computer or computer terminal simultaneously without the written consent of Infors Control.

Special license agreements are available for IRIS NT PRO, and NETWORK versions ONLY. Also, the History Viewer programme may be freely copied for users on the same site as the full software for the PRO and NETWORK versions.

2. COPYRIGHT
The SOFTWARE is owned by Infors AG or its suppliers and is protected by law and international treaty provisions. Therefore you must treat the SOFTWARE like any other copyright material (e.g., a book or musical recording) except that you may either (a) make one copy of the SOFTWARE solely for backup or archival purpose, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup or archival purpose. You may not copy the written materials accompanying the software.

3. OTHER RESTRICTIONS
You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and accompanying written materials on a permanent basis provided you retain no copies and the recipient agrees to the terms of this agreement. You may not reverse engineer, decompile, or disassemble the SOFTWARE.

4. DUAL MEDIA SOFTWARE
If the SOFTWARE package contains dual media, then you may use only the disks appropriate for your single-user computer. You may not use the other disks on another computer or loan, rent, lease, or transfer them to another user except as part of the permanent transfer (as provided above) of all SOFTWARE and written materials.

LIMITED WARRANTY

Infors AG warrants that (a) the SOFTWARE will perform substantially according to the accompanying written materials for a period of one year from the date of receipt; and (b) any hardware accompanying the SOFTWARE will be free from defects in materials and workmanship under normal use and service for a period of one year from the date of receipt. Any implied warranties on the SOFTWARE and hardware are limited to one year.

CUSTOMER REMEDIES

Infors AG's entire liability and your exclusive remedy shall be, at Infors' option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE or hardware that does not meet Infors Control's Limited Warranty and which is returned to Infors with a copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE or hardware has resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder of the original warranty period or 90 days, whichever is longer.
NO OTHER WARRANTIES

INFORS AG DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE, THE ACCOMPANYING WRITTEN MATERIALS, AND ANY ACCOMPANYING HARDWARE. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES

IN NO EVENT SHALL INFORS AG OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGE WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THIS PRODUCT, EVEN IF INFORS CONTROL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
## Contents

1  **OVERVIEW OF IRIS NT5**  
   1.1  Introduction ................................................................. 4  
   1.2  Major Features for IRIS NT5 PRO ........................................... 5  
   1.3  Quick guide for using IRIS NT ........................................... 6  
      1.3.1  START A FERMENTER .................................................. 6  
      1.3.2  STOP A FERMENTER .................................................. 7  
      1.3.3  BATCH TICKET .......................................................... 7  
      1.3.4  ADD/EDIT PARAMETERS .............................................. 8  
      1.3.5  CHANGE ON-LINE DISPLAY ......................................... 9  
      1.3.6  ALTER A SETPOINT .................................................. 9  
      1.3.7  ANALYSIS VALUES ................................................... 10  
      1.3.8  DISPLAY A HISTORY GRAPH ....................................... 11  
      1.3.9  COMPARISONS ......................................................... 11  
      1.3.10  ANNOTATE GRAPHS .................................................. 12  
      1.3.11  GENERATE REPORT .................................................. 13  
      1.3.12  USING CONTROL .................................................... 13  
      1.3.13  FOLLOW FILE .......................................................... 14  
      1.3.14  ALARM HANDLING .................................................. 14  

2  **INSTALLATION OF IRIS NT 5**  
   2.1  Installing the IRIS NT5 Software .......................................... 15  
      2.1.1  Starting IRIS ............................................................. 16  
   2.2  Defining the Associated Equipment ......................................... 16  
      2.2.1  Connecting the Fermenter ............................................. 16  
      2.2.2  Installing the Fermenter .............................................. 16  
      2.2.3  ISF and S-DDC Fermenters .......................................... 16  
      Parameters and Measured Values for ISF Fermenters ....................... 17  
      2.2.4  Labfors & Sixfors Fermenters ...................................... 17  
      Parameters & Measured Values for a Labfors without S-DDC setup ......... 17  
      2.2.5  Parameters and Measured Values for S-DDC Fermenters ...... 18  

3  **IRIS MAIN PROGRAM**  
   3.1  What is Inside ................................................................. 19  
   3.2  Off-Line Options, IRIS Main Program .................................... 19  
      3.2.1  Menus and Toolbar Buttons ......................................... 20  
      3.2.2  Starting a New Fermentation ....................................... 22  
      3.2.3  Opening an Existing Fermentation ................................. 24  
      3.2.4  Altering What is Displayed ......................................... 25  
   3.3  Parameters of Iris ........................................................... 25  
      3.3.1  Adding Parameters .................................................... 26  
      3.3.2  Parameter Data Parts in Detail ..................................... 26  
      3.3.3  Editing a Parameter .................................................. 30  
      3.3.4  Calibration of a Parameter ......................................... 30  
      3.3.5  Fermenter Options .................................................... 31  
      3.3.6  Sterilization Options ................................................ 33  
   3.4  Passwords & Logging In .................................................... 33  
      3.4.1  Users ........................................................................ 34  
      3.4.2  Defining Levels of Access Rights ................................... 35
4 HISTORY VIEWER & CORRELATION TOOL

4.1 Introduction ................................................................. 58
4.2 Menus & Toolbar Buttons .............................................. 59
  4.2.1 Before a File is Open .................................................. 59
  4.2.2 When a File is Open ...................................................... 60

4.3 Opening a File ............................................................. 62

4.4 Comparison ..................................................................... 64

4.5 Annotating Graphs .......................................................... 65
  4.5.1 Time Line ................................................................. 65
  4.5.2 Label Marker .............................................................. 66
  4.5.3 Time Marker ............................................................... 66
  4.5.4 Value Marker .............................................................. 67

4.6 Entering Analysis Data .................................................... 67

4.7 Generating Reports ......................................................... 68

4.8 The Correlation Tool ....................................................... 69

4.9 Printing ................................................................. 71

5 CONTROL OPTIONS ...................................................................... 73

5.1 Manual Control ............................................................... 73

5.2 Control Language Introduction ......................................... 73

5.3 Opening Control Language Sequences ................................. 74

5.4 Writing a Control Sequence .............................................. 74

5.5 Load Control Option .......................................................... 78

5.6 Control language Structure ................................................ 78

5.7 Command Structures ........................................................ 79

5.8 Mathematical Operators .................................................... 79

5.9 Relational Operators .......................................................... 79

5.10 Assignment ..................................................................... 79

5.11 Functions ...................................................................... 79

5.12 System Variables ............................................................. 80

5.13 Description of Commands ................................................. 81
  5.13.1 The RAMPC function .................................................. 81
  5.13.2 The RAMP function ...................................................... 82
  5.13.3 The LIMITS function .................................................... 83
  5.13.4 The ADJUST function ................................................... 84
  5.13.5 The LIM function ........................................................ 85
  5.13.6 List of IRIS Control Statement Operators ......................... 85
  5.13.7 PARAMETER COMPONENTS ............................................ 86
  5.13.8 FERMENTATION VARIABLES & CONSTANTS .................. 87
5.14 Command Language Examples ...............................................................87
  5.14.1 Linear increase of pH setpoint if oxygen concentration exceeds a certain value ..........................................................87
  5.14.2 PH setpoint has switches according oxygen concentration ....87
  5.14.3 Exponential increase of flow setpoint .........................................88
  5.14.4 Bi-directional exponential flow control rate system ...................88
  5.14.5 Calculate doubling time for biomass .........................................88
  5.14.6 Calculate the Biomass during exponential growth phase ..........89
  5.14.7 Calculate the CO2 evolution rate ............................................89
  5.14.8 Sample RQ calculation ............................................................89
  5.14.9 RQ control of a dosing pump ..................................................89

5.15 Extra Control Language Sequences................................................90
  5.15.1 One-way control of PO2 ............................................................90
  5.15.2 Using flow in a cascade control after rpm is at a maximum ......90
  5.15.3 SGM demo - simulation of effect on increasing Biomass on PO2 and stirrer .............................................................90
  5.15.4 Control of bi-phasic feed linked to time of fermentation (equivalent to growth stage of culture) .........................90
  5.15.5 Fermentation simulation sequence ............................................91
  5.15.6 Feeding according pO2 .............................................................91
  5.15.7 Pump Control sequences for IRIS with detailed explanations 92
  5.15.8 Additional Information about the Control Language ...............93
  5.15.9. Global Variables .................................................................93
  5.15.10 Debugger .............................................................................94

5.18.11 Notes on Object Linking & Embedding (OLE) and IRIS NT Pro.96

6 FOLLOW FILE 98

How do I use Follow File.................................................................98
6.1 Follow File Generator for Time-based Profiling ...........................100

7. User log. 102

8 TROUBLESHOOTING 103
  8.1 Overview 103

9 APPENDICES 105
  9.1 Brief Guide to the Windows features used in IRIS NT .................105
    9.1.1 Properties of Active Windows ...............................................106
    9.1.2 Dialogue Boxes .................................................................107
    9.1.3 Drop Down Lists (Combo Box) ............................................107
    9.1.4 Radio Buttons .....................................................................107
    9.1.5 Keyboard Shortcuts and Menu Options ...............................108
  9.2 Request a file by FTP .................................................................108
  9.3 Send a File by e-mail .................................................................109
  9.4 IRIS Applets .............................................................................109

10 Glossary of Terms 111

11 Index 112
1 OVERVIEW OF IRIS NT5

1.1 Introduction
This software represents the next stage of development in a long-established and fully featured program for data-logging and control of single or multiple fermenters. IRIS version 5 is specifically designed for the Windows 7, 2000, XP or Windows 98 operating systems or higher. The features and capabilities of earlier versions have been retained but the newer operating environment allows for even greater ease of use. IRIS version 5 is fully Windows compliant and has been designed to function in the same familiar way as e.g. a word processor or spreadsheet running under the same operating system. Options such as printing are set up in completely standard ways and data can be exchanged between IRIS and other applications running simultaneously.

To get the best from this program, a basic familiarity with Windows by the operator is assumed. Specific points to note are the use of the right mouse button to show certain menus and dialogue boxes and the use of double-clicking for certain actions. If you are not sure about your level of familiarity with standard Windows features for entering and editing information please consult the relevant help files and tutorial supplied with the operating system.

IRIS Version 5 is not a single program but a family of applications which meets the needs of users at several different levels. A full list of features for each variant is provided as part of this manual. For the sake of completeness, this manual is based on the IRIS PRO version and any features not covered will also be included in the appendices. If an option is greyed out or does not appear to work please check that your version of IRIS is supposed to support the specific feature.

An outline operating guide is supplied along with this manual. Please use this for a short treatment of everyday tasks within IRIS once it is configured and working properly. The objective of this manual is to give a comprehensive explanation of the many features within IRIS. Specifically, examples are provided for the control language and use of the follow-file facility, which the guide only mentions.

The latest version of IRIS, NT5, offers considerable benefits in terms of easy handling and flexibility of both data display and control options.

The major changes are as follows:

- **Totally redesigned on-line graphics which now include multi-axes, zoom and drag options.**
- **A profile generator for the Follow File option allowing easy set up of time-based profiling.**
- **Simplification of sequence writing by the addition of a wizard to help with selection of the correct control structures.**
- **A User Log facility which records actions taken (in line with FDA "Part 11" compliance)**

Other features and facilities within IRIS remain broadly as the previous version and existing users will have no difficulty making full use of the new capabilities in version 5.
1.2 Major Features for IRIS NT5 PRO

- Data-logging with variable logging rates for individual parameters and log-by-diff.
- Logging of user actions for regulatory and validation purposes
- Alarm files with the options to both view and acknowledge alarms
- Multiple fermenter operation, mixture of fermenter types
- Automatic control of sterilization for appropriate fermenters
- Ability to add optional drivers for peripheral equipment eg. a mass spectrometer.
- Range of different type of parameter eg. measured, analysis, calculated, pump
- Control of external pumps
- Use of set-up recipes
- Different type of real-time display eg. text, bar, schematic and comprehensive on-line graphics
- Graphical display of archived data using History module
- Time line and various annotation options
- Comprehensive reporting and set-up options for communications
- Comparison and correlation of multiple fermenter files
- Back-up values for parameters for security of operation and modelling.
- Creation of batch tickets
- Follow file facility to provide automatic generation of set points from archived data & time-based profiles with the "follow file generator".
- Report generation and export of data to other applications
- Compliance control language with a wide range of facilities for Supervisory Set-Point Control (SSPC)
- Ability to change parameter settings by time or conditionally. Ramping.
- Use of global variables to pass information between fermenters
- OLE links to external applications using parameter passing mediated by Visual Basic programs.
- Password protection and user access rights for security in operation
- Ability to transfer data on a network
- Remote control options
- Links to external sources of data via a serial port using a generic ASCII driver option
- Use of History module independent of the the main IRIS program
- Runs on any modern PC eg. a Pentium PIII or better with SVGA graphics, minimum of 128MB RAM if used with XP, and hard disk. Optional network card.
## 1.3 Quick guide for using IRIS NT

### 1.3.1 START A FERMENTER

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX NAME</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="FILE menu, NEW FERMENTATION" /></td>
<td>SELECT FERMENTER</td>
<td>List of available fermenters</td>
</tr>
<tr>
<td><img src="image" alt="on desired fermenter" /></td>
<td>FERMENTER STARTUP OPTIONS</td>
<td>Enter Title: Name&amp;No.iri</td>
</tr>
<tr>
<td><img src="image" alt="on desired fermenter" /></td>
<td></td>
<td>Enter Phase: Fermentation Inoculation Sterilization</td>
</tr>
<tr>
<td><img src="image" alt="option" /></td>
<td></td>
<td>Option Select recipe file BROWSE</td>
</tr>
<tr>
<td><img src="image" alt="on New button" /></td>
<td>SELECT FERMENTER</td>
<td>List of available fermenters</td>
</tr>
<tr>
<td><img src="image" alt="FILE menu" /></td>
<td>OPEN</td>
<td>Select desired file</td>
</tr>
<tr>
<td><img src="image" alt="OPEN - OPEN" /></td>
<td></td>
<td><img src="image" alt="Open as receipt" /></td>
</tr>
<tr>
<td><img src="image" alt="NEXT" /></td>
<td>FERMENTER PARAMETERS</td>
<td>Select desired parameters from Left-hand List</td>
</tr>
<tr>
<td><img src="image" alt="on parameter" /></td>
<td></td>
<td>Transfer to Right-hand list. Option</td>
</tr>
<tr>
<td><img src="image" alt="&gt;&gt; button to transfer" /></td>
<td></td>
<td>Select parameter in Right-hand list</td>
</tr>
<tr>
<td><img src="image" alt="on parameter" /></td>
<td>EDIT MEASURED PARAMETER</td>
<td>Edit Parameter definitions</td>
</tr>
<tr>
<td><img src="image" alt="EDIT button to alter" /></td>
<td>(or Analysis, Calculated or Pump)</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="NEXT" /></td>
<td>FERMENTER CONTROL</td>
<td>Options</td>
</tr>
<tr>
<td><img src="image" alt="FINISH" /></td>
<td>IRIS NT confirmation box</td>
<td><img src="image" alt="OK" /></td>
</tr>
<tr>
<td></td>
<td>Shows time/date of startup</td>
<td></td>
</tr>
</tbody>
</table>
## 1.3.2 STOP A FERMENTER

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>on the X of the fermenter window which you would like to close</td>
<td>IRIS NT CLOSDOWN FERMENTER</td>
<td>OK CANCEL</td>
</tr>
<tr>
<td>on OK to end fermentation</td>
<td>WAIT</td>
<td></td>
</tr>
</tbody>
</table>

**Option**

- **FILE MENU**
- **CLOSE**

## 1.3.3 BATCH TICKET

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHEN FERMENTER IS ACTIVE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDIT MENU</td>
<td>SUBMENU BATCH TICKET</td>
<td>SUB-SUB-MENU EDIT CURRENT CREATE NEW</td>
</tr>
<tr>
<td>LOAD NEW</td>
<td>OPEN</td>
<td>Enter File name of the current fermentation</td>
</tr>
<tr>
<td>OPEN</td>
<td>NOTEPAD</td>
<td>Enter data as freeform text - Eg. operator, inoculum history, raw materials history etc.</td>
</tr>
</tbody>
</table>

**FILE MENU**

**SAVE**

**EXIT**
### 1.3.4 ADD/EDIT PARAMETERS

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>![PARAMETERS MENU]</td>
<td>SUB-MENU ADD/EDIT</td>
<td>ADD</td>
</tr>
<tr>
<td>![PARAMETER TYPE]</td>
<td>SUB-SUB MENU TYPE</td>
<td>Measured, Analysis, Calculated, Pump, Digital, Gas Analyser, Balance</td>
</tr>
<tr>
<td>![OK BUTTON]</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Option</strong> EXISTING FERMENTER</td>
<td>PARAMETERS</td>
<td>Select from list of all available parameters</td>
</tr>
<tr>
<td>![SUB-SUB-MENU EDIT]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>![to highlight a parameter]</td>
<td></td>
<td>EDIT, COPY, CALIBRATE, DELETE</td>
</tr>
<tr>
<td>![Required Button eg. EDIT]</td>
<td>EDIT PARAMETER</td>
<td>Choices as above</td>
</tr>
<tr>
<td><strong>Option</strong> WHEN FERMENTER IS ACTIVE</td>
<td>FERMENTER PARAMETERS</td>
<td>Select a new parameter to add, Select a chosen parameter to EDIT</td>
</tr>
<tr>
<td>![PARAMETER SETTINGS]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>![EDIT BUTTON]</td>
<td>EDIT... PARAMETER</td>
<td>Choices as above</td>
</tr>
</tbody>
</table>
### 1.3.5 CHANGE ON-LINE DISPLAY

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button]</td>
<td>TOOLBAR</td>
<td>TEXT OVERVIEW</td>
</tr>
<tr>
<td>![Button]</td>
<td>TOOLBAR</td>
<td>Shows Phase, Duration &amp; other text-based data</td>
</tr>
<tr>
<td>![Button]</td>
<td>TOOLBAR</td>
<td>GRAPHICAL OVERVIEW</td>
</tr>
<tr>
<td>![Button]</td>
<td>TOOLBAR</td>
<td>Allows use of zoom buttons Plus “follow last changed point” button for a “chart recorder” display</td>
</tr>
<tr>
<td>![Button]</td>
<td>TOOLBAR</td>
<td>on background to alter display properties</td>
</tr>
<tr>
<td>![Button]</td>
<td>TOOLBAR</td>
<td>SCHEMATIC OVERVIEW</td>
</tr>
<tr>
<td>![Button]</td>
<td>TOOLBAR</td>
<td>on background to load/ change bitmap and to add/ remove parameters</td>
</tr>
<tr>
<td>![Button]</td>
<td>TOOLBAR</td>
<td>on Parameter box to alter properties</td>
</tr>
<tr>
<td>![Button]</td>
<td>TOOLBAR</td>
<td>BAR -GRAPH OVERVIEW</td>
</tr>
</tbody>
</table>

Option

VIEW MENU

Required View

Text
On-Line
Schema
Bar

Zoom & Properties options on menu for appropriate views

### 1.3.6 ALTER A SETPOINT

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button] on a parameter from any live data view</td>
<td>QUICK EDIT PARAMETER</td>
<td>Change setpoint using the slider bar</td>
</tr>
<tr>
<td>![Button] APPLY BUTTON</td>
<td></td>
<td>Change other properties such as remote ON/OFF if needed</td>
</tr>
<tr>
<td>![Button] OK</td>
<td></td>
<td>Returns to display screen</td>
</tr>
</tbody>
</table>
### 1.3.7 ANALYSIS VALUES

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHEN FERMENTER IS ACTIVE</td>
<td>ANALYSIS PARAMETER</td>
<td>Enter Days, Hours, Minutes &amp; Value in text boxes</td>
</tr>
<tr>
<td>on required analysis parameter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADD BUTTON</td>
<td></td>
<td>Values etc. displayed in list format</td>
</tr>
<tr>
<td>CLOSE BUTTON</td>
<td></td>
<td>Return to data view</td>
</tr>
<tr>
<td>Option</td>
<td></td>
<td>Discounts data from graphs, reports etc.</td>
</tr>
<tr>
<td>REJECT BUTTON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option FROM HISTORY VIEWER</td>
<td>PARAMETER OPTIONS</td>
<td>EDIT ANALYSIS button to add data using the same method as for on-line additions</td>
</tr>
<tr>
<td>on required analysis parameter</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 1.3.8 DISPLAY A HISTORY GRAPH

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>IF IRIS NT IS ACTIVE</td>
<td>FILE MENU SUBMENU OPEN</td>
<td>File names of all *.iri files in the Infors AG subdirectory</td>
</tr>
<tr>
<td>HISTORY</td>
<td>OPEN MAIN GRAPHICAL DISPLAY WINDOW</td>
<td>Two sections: Graph display Bar display</td>
</tr>
<tr>
<td>On required file to start the History Viewer Application</td>
<td></td>
<td>Pull dividing bar to adjust size of Bar area up/down</td>
</tr>
<tr>
<td>On Parameter Bar</td>
<td>Tick Box ON/OFF Parameter highlights in blue</td>
<td>Parameter will display if ticked. If highlighted in blue, Value button can be used with the chosen parameter.</td>
</tr>
<tr>
<td>On Parameter bar</td>
<td>PARAMETER OPTIONS</td>
<td>Choose colour, line style, marker style. See parameter statistics Edit Analysis data if relevant.</td>
</tr>
<tr>
<td>On Graph Background</td>
<td>GRAPH VIEW OPTIONS</td>
<td>Choose grid, time base, colours for graph, single axis</td>
</tr>
<tr>
<td>ZOOM BUTTONS ON TOOLBAR</td>
<td>ZOOM IN ZOOM OUT ZOOM TO FIT (1:1)</td>
<td>Select degree of detail in Graphical display.</td>
</tr>
</tbody>
</table>

### 1.3.9 COMPARISONS

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPEN FIRST FILE AS 1.2.8.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FILE MENU AGAIN</td>
<td>OPEN FOR COMPARISON</td>
<td>Displays choice of *.iri files</td>
</tr>
<tr>
<td>OPEN FOR COM’P’SON</td>
<td>SELECT PARAMETERS TO COMPARE</td>
<td>Bars displayed from chosen parameters from second file Can be ticked for graphing</td>
</tr>
<tr>
<td>Selected file</td>
<td>MAIN DISPLAY WINDOW GRAPHS &amp; BARS</td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 1.3.10 ANNOTATE GRAPHS

<table>
<thead>
<tr>
<th>ACTIONS</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
</table>
| ![Time Line] | Red Line on Graph Display | ![on line, hold button and drag along graph.](Image)  
Values shown in Bar display relate to where the time lines is crossing the graph traces. |
| ![Time Line Button Again to Reset] | | |
| ![Label] | Text box and Marker appear on graphical display | ![on marker line, hold and drag to chosen location.](Image)  
The text box can be picked up and moved in the same way.  
Text edit box for entering message. Message is shown on graph in box.  
Choice for line, box shape, box colour, font etc. |
| ![On Label Box] | TEXT MARKER | |
| ![On Label Button Again to Reset] | | |
| ![Time] | Time box and Marker appear on graphical display | ![on marker line, hold and drag marker line end to the required time axis line.](Image)  
The time box can be moved in the same way.  
Choice for line, box shape, box colour, font etc.  
Time is shown in the box on graph |
| ![On Time Box] | TIME MARKER | |
| ![On Time Button Again to Reset] | | |
| ![On a Parameter to Select] | Highlights in blue | Value button on toolbar becomes available |
| ![On Value] | Value box and Marker line appear on graphical display - marker line is linked to the trace of the selected parameter | ![on marker line end, hold and drag along parameter trace to the desired position.](Image)  
The Parameter box can be moved in the same way  
Choice for line, box shape, box colour, font etc.  
Value is shown in box on graph |
| ![On Value Box] | PARAMETER MARKER | |
| ![On Value Button Again to Reset] | | |
### 1.3.11 GENERATE REPORT

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOAD FILE AS 1.2.8.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FILE MENU AGAIN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GENERATE REPORT</td>
<td>REPORT WIZARD (1)</td>
<td>List of available parameters to select &amp; highlight in turn</td>
</tr>
<tr>
<td></td>
<td>List of selected parameters</td>
<td>&gt;&gt; button to move to selected list</td>
</tr>
<tr>
<td>NEXT BUTTON</td>
<td>REPORT WIZARD (2)</td>
<td>Start or Inoc. Time</td>
</tr>
<tr>
<td></td>
<td>Batch Ticket &amp; Report Header</td>
<td></td>
</tr>
<tr>
<td>NEXT BUTTON</td>
<td>REPORT WIZARD (3)</td>
<td>Include Alarms</td>
</tr>
<tr>
<td></td>
<td>Averaging ON/OFF</td>
<td>Method of Averaging</td>
</tr>
<tr>
<td>FINISH</td>
<td>MAIN REPORT DISPLAY</td>
<td>Save, Print, Print Preview</td>
</tr>
<tr>
<td></td>
<td>Columns of text data</td>
<td>Cut, Copy, Paste</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Regenerate Report</td>
</tr>
<tr>
<td>CLOSE OPTION</td>
<td>RETURN TO MAIN SCREEN</td>
<td></td>
</tr>
</tbody>
</table>

### 1.3.12 USING CONTROL

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>DURING STARTUP AS 1.2.1</td>
<td>FERMENTER CONTROL</td>
<td>Control Sequence Option</td>
</tr>
<tr>
<td>On Browse Button</td>
<td>OPEN</td>
<td>List of *.SEQ sequence files</td>
</tr>
<tr>
<td>Required sequence File to load</td>
<td>File name in Text dialogue Box</td>
<td></td>
</tr>
<tr>
<td>FINISH</td>
<td>Fermenter Starts when OK Button pressed</td>
<td>Sequence Active -No further action if no modifications</td>
</tr>
<tr>
<td>EDIT MENU</td>
<td>CONTROL SEQUENCE SUBMENU</td>
<td></td>
</tr>
<tr>
<td>EDIT CURRENT SUB-SUB MENU</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDIT CURRENT</td>
<td>COMPILER SCREEN</td>
<td>SEQUENCE AVAILABLE FOR EDITING AS TEXT FILE</td>
</tr>
<tr>
<td>FILE NAME SHOWN</td>
<td>APPLY SEQUENCE</td>
<td>YES NO SEQ No.</td>
</tr>
<tr>
<td>YES</td>
<td>MAIN PROGRAM SCREEN</td>
<td>SEQ No. &amp; TIME SHOWN IN BOTTOM STATUS LIN</td>
</tr>
<tr>
<td>CLOSE OPTION</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 1.3.13 FOLLOW FILE

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>DURING STARTUP AS 1.2.1. On Browse Button</td>
<td>FERMENTER CONTROL OPEN</td>
<td>Follow File Option</td>
</tr>
<tr>
<td>on selected file</td>
<td>List of parameters in new fermentation on left</td>
<td>List of *.iri Files</td>
</tr>
<tr>
<td>on selected NEW parameter</td>
<td>FOLLOW PARAMETER SELECTION</td>
<td>on follow file parameter to be used as template for the new parameter</td>
</tr>
<tr>
<td>Repeat for all required parameters</td>
<td>Fermenter starts when OK button pressed</td>
<td></td>
</tr>
</tbody>
</table>

### 1.3.14 ALARM HANDLING

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DIALOGUE BOX</th>
<th>CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>on ALARM Window</td>
<td>ALARM’s Window to front</td>
<td>List of outstanding alarms shown</td>
</tr>
<tr>
<td>on selected alarm data to highlight</td>
<td>CLEAR Button appears</td>
<td></td>
</tr>
<tr>
<td>to clear Alarm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>to move down to next alarm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option: on first selected alarm message</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SHIFT on last selected alarm message to highlight all</td>
<td></td>
<td></td>
</tr>
<tr>
<td>on highlighted areas</td>
<td>CLEAR button appears</td>
<td></td>
</tr>
<tr>
<td>to clear selected alarms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>again to clear highlights</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2 INSTALLATION OF IRIS NT 5

2.1 Installing the IRIS NT5 Software

The Windows NT5 version of the IRIS software comes on one CD Rom. First, turn the Computer on, when Windows is started, place the CD Rom in the CD Rom drive of your computer. The setup.exe on the CD Rom will start automatically if option autorun is activated. If it does not start automatically, the normal protocol for “Add/Remove Programs” must be started from Windows. Alternatively, quit all active programs and manually install the software by running the program.

“Letter Cdrom Drive “E”:\Setup.exe”.

An automatic installation program will now take over and ask several questions before installing the software to its own Infors AG folder within the Program Files sub-directory. All program, data and control sequence files are stored in this folder unless you specify otherwise.

Unless you have good reason to do otherwise, accept the option for a full installation when asked or vital Dynamic Linked Library (.dll) files required by IRIS may be missing.

If anything goes wrong with the procedure at this stage please contact your local Infors agent for advice or use our e-mail facilities for direct help (headoffice@infors-hc.com).

The software installs in approximately 27MB of hard disk space but additional capacity must be available for the data files which will be created. It is not possible to predict exactly how much space is needed as different conditions of use will apply to different fermentations. As an example, data-logging 5 parameters for one hour at one minute intervals each (a relatively high log rate for most parameters) will create a file approximately 50K in size. A simple control sequence will create a file of only a kilobyte or so.

All IRIS data files have the structure FILENAME.iri and show the icon. Control sequences are now stored with the main .iri file and are essentially Notepad files, which are compiled as needed. Of course, long file names can be used in the Windows environment. IRIS expects to find a number of information files in its default sub-directory and moving files other than data or sequence files is not recommended.

When installation is complete, a desktop shortcut can be made to the main IRIS program –see your Windows operating manual for how to do this. This allows “double click” access to IRIS directly from the desktop. IRIS provides access to all other functions but the History viewer icon can also be installed as a separate shortcut for data analysis/report generation without running the data-logging and control parts of IRIS. Some smaller applets related to the DDC instrumentation need starting independently.
2.1.1 Starting IRIS

Double click on the IRIS icon from a desktop shortcut, the Programs section of the START menu or the Infors AG folder.

An opening screen will then load and IRIS will open with the default user logged in. A first, only the Alarms window is open within the main IRIS window. Every active fermenter has its own window and these can be minimised or moved within the main IRIS window.

The main window comprises a menu bar with a toolbar beneath. The bottom part of the window is a status display with descriptive information about menu options and details of the active fermentation. The position and range of options provided on both the menu and toolbar areas is fully Windows NT4 and Windows 95 compliant. Therefore, this manual will concentrate on those items which are specific to IRIS. For help in using the standard features of Windows please consult the reference manuals and built-in tutorials provided by Microsoft Windows.

2.2 Defining the Associated Equipment

A few adjustments have to be made before IRIS can capture data and control a fermenter. IRIS can accommodate various types of fermenters, those of a similar design being connected via a single communications port. If you wish to add even more fermenters these can be connected to a different com port.

2.2.1 Connecting the Fermenter.

The computer must firstly have a free serial port. Start IRIS and go to the Peripherals dialogue box (Extras, Devices) as shown in Figure 2.1.

Enter the fermenter type and the corresponding serial communication port associated with it. Enter the com port parameters corresponding to those given in the fermenter manual i.e. appropriate to the fermenter type. Standard settings are shown in the accompanying illustration.

2.2.2 Installing the Fermenter

Every fermenter must be correctly installed before it can be used for the first time. All settings options can be found in the Fermenter - Edit Settings dialogue screen.

After you have selected the working fermenter, the dialogue box in the accompanying illustration appears. In this section, the fields “Device Model” and “Port” settings must be entered. Every usable fermenter must have its “Switch No” and “Ferm Code” settings entered.

2.2.3 ISF and S-DDC Fermenters.

Some ISF and S-DDC types of fermenter can operate in a multi-fermenter mode, making switch number relevant. You must enter which port on the switch box each fermenter is plugged into. Each fermenter must have its ID No (ISF) or its Unit ID (S-DDC) selected. Position 1 of the switch box has fermenter ID 0, position 2 is ID1 etc.
Parameters and Measured Values for ISF Fermenters

<table>
<thead>
<tr>
<th>Name</th>
<th>Input Chan.</th>
<th>Output Chan</th>
<th>Maxi. value</th>
<th>Mini. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp</td>
<td>0</td>
<td>0</td>
<td>130 °C</td>
<td>0</td>
</tr>
<tr>
<td>RPM</td>
<td>1</td>
<td>1</td>
<td>2000 min-1</td>
<td>0</td>
</tr>
<tr>
<td>PH</td>
<td>2</td>
<td>2</td>
<td>12</td>
<td>2</td>
</tr>
<tr>
<td>pO2</td>
<td>3</td>
<td>3</td>
<td>100 %</td>
<td>0</td>
</tr>
<tr>
<td>PCo2</td>
<td>4</td>
<td>4</td>
<td>100 %</td>
<td>0</td>
</tr>
<tr>
<td>Flow</td>
<td>5</td>
<td>5</td>
<td>10 l/min(or Max)</td>
<td>0</td>
</tr>
<tr>
<td>Pressure</td>
<td>6</td>
<td>6</td>
<td>2 bar(or Max)</td>
<td>0</td>
</tr>
<tr>
<td>Weight</td>
<td>7</td>
<td>7</td>
<td>20 kg(or Max)</td>
<td>0</td>
</tr>
<tr>
<td>Redox</td>
<td>8</td>
<td>8</td>
<td>1000/500 mV</td>
<td>0</td>
</tr>
<tr>
<td>Opt.Dens</td>
<td>9</td>
<td>9</td>
<td>100 %</td>
<td>0</td>
</tr>
<tr>
<td>O2</td>
<td>10</td>
<td>10</td>
<td>100 %</td>
<td>0</td>
</tr>
<tr>
<td>CO2</td>
<td>11</td>
<td>11</td>
<td>100 %</td>
<td>0</td>
</tr>
<tr>
<td>User1</td>
<td>12</td>
<td>12</td>
<td>10 V</td>
<td>0</td>
</tr>
<tr>
<td>User2</td>
<td>13</td>
<td>13</td>
<td>10 V</td>
<td>0</td>
</tr>
<tr>
<td>User3</td>
<td>14</td>
<td>14</td>
<td>10 V</td>
<td>0</td>
</tr>
<tr>
<td>User4</td>
<td>15</td>
<td>15</td>
<td>10 V</td>
<td>0</td>
</tr>
</tbody>
</table>

2.2.4 Labfors & Sixfors Fermenters.

The newest variety of Sixfors, Labfors and Techfors fermenters can be used in S-DDC mode. With "traditional" Labfors/Sixfors/Minifors in "Labfors" mode, the fermenter code must be entered. Labfors and Sixfors fermenters can be given a “Master ID No.” The Master ID No. and the fermenter code MUST be the same (for a single Labfors this would typically be 0 and 0). With more than one Labfors Master unit, connected by a single serial cable, each Master unit MUST have a unique ID number.

Older Labfors and Sixfors cannot be used with a switchbox. The Switch No. is therefore used as the identifier for the Labfors Satellite units or the individual Sixfors vessels. The Labfors Master always has Switch No. 0, the first satellite unit is Switch No 1 and so on. In the case of the Sixfors, this is analogous to entering the vessel number (1 -6). The vessels are numbered from left to right.

A Labfors 1 or 2 with an Analogue Box MUST be used in S-DDC mode in order for the additional channels to be accessed. A Labfors in S-DDC mode reserves 5 satellites for the chosen ID No. For this reason, a Labfors with Analogue Box is best used on a single serial port. A Labfors 3 is always used in S-DDC mode.

Parameters & Measured Values for a Labfors without S-DDC setup.

<table>
<thead>
<tr>
<th>Name</th>
<th>Input Chan.</th>
<th>Output Chan</th>
<th>Maxi. Value</th>
<th>Min. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPM</td>
<td>0</td>
<td>0</td>
<td>1500</td>
<td>0</td>
</tr>
<tr>
<td>Temp</td>
<td>1</td>
<td>1</td>
<td>60</td>
<td>0</td>
</tr>
<tr>
<td>PH</td>
<td>2</td>
<td>2</td>
<td>12</td>
<td>2</td>
</tr>
<tr>
<td>PO2</td>
<td>3</td>
<td>3</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>AF</td>
<td>4</td>
<td>4 (no function)</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Acid Pump</td>
<td>5</td>
<td>7 (only used when pump is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Base Pump</td>
<td>6</td>
<td>8 (only used when pump is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Afoam Pump</td>
<td>7</td>
<td>4 (only used when pump is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Feed Pump</td>
<td>8</td>
<td>5 (only used when pump is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Mass Flow</td>
<td>9</td>
<td>9 (only used when Flow is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Gas Mix</td>
<td>13</td>
<td>10 (only used when Mix is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
2.2.5 Parameters and Measured Values for S-DDC Fermenters

The parameter number and measured values settings must be entered in the Parameters group for that fermenter.

Parameters and Measured Values for Labfors Fermenters in S-DDC mode.

<table>
<thead>
<tr>
<th>Name</th>
<th>Input Chan.</th>
<th>Output Chan.</th>
<th>Maxi. Value</th>
<th>Min. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPM</td>
<td>0</td>
<td>0</td>
<td>1500</td>
<td>0</td>
</tr>
<tr>
<td>Temp</td>
<td>1</td>
<td>1</td>
<td>60</td>
<td>0</td>
</tr>
<tr>
<td>pH</td>
<td>2</td>
<td>2</td>
<td>12</td>
<td>2</td>
</tr>
<tr>
<td>pO2</td>
<td>3</td>
<td>3</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>AF</td>
<td>4</td>
<td>4 (no function)</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>In1</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Out1</td>
<td>5</td>
<td></td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>In2</td>
<td>6</td>
<td></td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Out2</td>
<td>6</td>
<td></td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>In3</td>
<td>7</td>
<td></td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Out3</td>
<td>7</td>
<td></td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>In4</td>
<td>8</td>
<td></td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Out4</td>
<td>8</td>
<td></td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>In5</td>
<td>9</td>
<td></td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Out5</td>
<td>9</td>
<td></td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Out6</td>
<td>10</td>
<td></td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Acid Pump</td>
<td>0</td>
<td>11(*)</td>
<td>Pump On</td>
<td></td>
</tr>
<tr>
<td>Base Pump</td>
<td>1</td>
<td>12(*)</td>
<td>Time in Seconds</td>
<td></td>
</tr>
<tr>
<td>AFoam Pump</td>
<td>2</td>
<td>13(*)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feed Pump</td>
<td>3</td>
<td>14(*)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mass Flow</td>
<td>15</td>
<td>15 (only used when Flow is switched to ON)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gas Mix</td>
<td>16</td>
<td>16 (only used when Mix is switched to ON)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* only used when pump is switched to ON

Note: The Sixfors Maximum speed is either 800 or 1200 rpm, depending on drive system settings.

2.2.6 Parameters & Measured Values for a Minifors

<table>
<thead>
<tr>
<th>Name</th>
<th>Input Chan.</th>
<th>Output Chan.</th>
<th>Maxi. Value</th>
<th>Min. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPM</td>
<td>0</td>
<td>0</td>
<td>300 or 1250</td>
<td>0</td>
</tr>
<tr>
<td>Temp</td>
<td>1</td>
<td>1</td>
<td>60</td>
<td>0</td>
</tr>
<tr>
<td>pH</td>
<td>2</td>
<td>2</td>
<td>12</td>
<td>2</td>
</tr>
<tr>
<td>pO2</td>
<td>3</td>
<td>3</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>AF</td>
<td>4</td>
<td>4 (no function)</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Acid Pump</td>
<td>5</td>
<td>5 (only used when pump is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Base Pump</td>
<td>6</td>
<td>6 (only used when pump is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>AFoam Pump</td>
<td>7</td>
<td>7 (only used when pump is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Feed Pump</td>
<td>8</td>
<td>8 (only used when pump is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>O2 valve</td>
<td>9</td>
<td>9 (only used when valve is switched to ON)</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

N.B. IRIS cannot start or stop a Minfors or its individual parameters. They must be switched ON before starting IRIS

N.B. For multiple fermenters, parameters can be copied and the select mask altered to make set up a much shorter and simpler process (see following sections).
3 IRIS MAIN PROGRAM

3.1 What is Inside

This is the core of the IRIS software where data is captured from one or more fermenters, displayed in several different views and logged to disk. Along with these basic functions, the software performs a number of additional tasks such as alarm handling, creation and editing of parameter data relating to process variables, preparation of batch tickets and security (passwords and access rights for individual users). Control functions include the sending of setpoint data to one or more fermenters under remote control (Supervisory Set Point Control - SSPC) and automatic sterilization for larger fermenters. Not every function is available in all versions of IRIS - please check the features list in Appendix 1 to find out if a particular option is supported by your version of the software.

Some of these functions can be accessed when no fermenter is active whereas others can only be applied to fermenters which are in operation. This natural division is used in the current chapter.

3.2 Off-Line Options, IRIS Main Program
### 3.2.1 Menus and Toolbar Buttons

The opening screen (Figure 3.1) appears after the IRIS title screen and a message that the “default user” is logged on. Click on the “OK” button to proceed. A number of functional checks are made by the software at this early stage and a warning message may appear if, for example, a required library file cannot be found.

By default, the **Alarm** messages window and **User actions** window open within the main IRIS program window. These can be closed by pressing the “x” button on the far right of the Alarms window if desired. However, it is not necessary as fermenter windows will start “over the top” of the Alarms and User windows. The data from the User action windows can be archived at any point by right clicking on the screen and then saving the file using the **Store as archive** button which appears.

A number of menu options are available and, by default, both the **Toolbar** (at the top of the window) and **Status Bar** (at the bottom of the window) are active to give more choices and information.

It is assumed at this stage that you are already familiar with the basic operation of Windows NT4 and/or Windows 9x in terms of manipulation of individual windows, use of dialogue boxes and help.

The **File** menu is the starting point for activating a new fermentation and using archived data.

The **New** (Start Fermenter) option is used when you want to begin with a completely fresh selection of parameter choices and options rather than use existing data as a template. Clicking on this option leads to a series of dialogue boxes which will be discussed in the next section. Note that a keyboard shortcut (Ctrl+N) is also available for this option.

The second option, **Open**, leads to a “pop-up” submenu with the options to open a History Viewer use the Correlation tool or create/edit a Follow File. They allow work on archived data without starting a fermentation. All these options are programs in their own right and can also be run independently of IRIS.

The **Open** option leads to a file selection window and the option to open a selected file as a receipt (recipe) for rapid set-up of a new fermentation when it follows the pattern of an archived file. Several dialogue boxes are also used when this option is chosen.

The **Print Setup** leads to the standard windows options for specifying the output to any of the installed printers on your system.

**Fermentation** leads to a “pop-up” submenu where all the possible options are greyed out at this stage. Below this, a section of the menu box labelled **1..4** lists the most recently used files for rapid selection.

**Exit** closes the IRIS main program.

The **View** Menu option controls which parts of the IRIS program window will be displayed by clicking on an option to select or de-select it. A tick shows an option is selected. By default, all the options appear on screen when IRIS is first started.

The **Parameters** menu option again starts with a simple choice to add or edit a parameter (process variable such as temperature, pH etc.). Selecting **Add** leads to a “pop-up” submenu which lists all the possible choices such as measured, calculated, analysis etc. Selecting **Edit** gives access to those parameters which are already created to allow changes to be made.

Section 3.3. gives full details on how to add and edit parameters.
The Fermenter menu only has the option to **Edit settings** at this stage. Other options depend on a fermenter being active (see Section 3.2.2). Edit Settings leads to a selection window for picking an individual fermenter and then the dialogue box shown in Figure 2.

**Passwords** gives a number of options which lead to text edit boxes or selection windows, depending on the item chosen. **Login** allows an individual to enter their name and password to gain access to IRIS. Change password allows that user to select a new password (changing passwords regularly is a wise security measure). **Login Default** determines who will be given access to the system at startup. This is normally "admin" when the IRIS program is newly installed. **User** opens a selection window with all named users of the system listed with options for **Add**, **Remove** and **Edit**. The first two options are clear and the edit function is activated when a user in the list is clicked on with the mouse. At this point, a text edit dialogue box is opened with a number of options relating to that user's password and the access they can be given to various features within IRIS.

**Define Levels** leads to a selection window and text edit boxes related to a feature in IRIS called “Access Rights”. This assigns all the important features in the program such as starting a fermenter or changing a setpoint a specific number between 0 and 254. The higher the number, the more critical a particular feature is deemed to be. Each named user is then given a number. If a feature has a number associated with it lower than that of a particular user, then the user can access that particular function. If the feature has a higher number, the individual user cannot access that feature. The designated administrator for the system controls who has which rights to access features.

**Extras** covers the interaction of IRIS with the external equipment (usually fermenters) which it logs and controls. **Devices** leads to a **Devices** dialogue box already shown in Figure 2.1, where the type of fermenter eg. SDDC or Labfors is associated with a particular serial communications (RS232/485) port. A **Settings** button lets the communications protocol (data bits, stop bits parity) be set for each port. **Statistics** is not active until a fermentation is active (see Section 3.2.2). **Specials** leads to a dialogue box with edit text boxes which allow the options **alarm repeat delay**, **autosave period**, the **default path** and **screensaver lock** to be set according to user preferences.
The **Windows** menu leads to the standard options supplied by the operating system for **cascading** or **tiling** windows plus **arranging icons** along the bottom of the window. Active windows are shown. **Help** gives you access to specific help Topics and an About message window giving the version. The following toolbar buttons are available for use before a fermentation is started:

- This is a quick way to start a **New** fermentation.
- Opens an existing file.
- Saves a file to disk
- Access to the **History** Viewer
- Access to the **Correlation** tool
- **Passwords** can be entered via this button.
- **Help**
- **Context-sensitive help.** Place the special cursor over an item and click to reveal information.

Other options which are greyed out and unavailable at this stage will be covered fully in Section 3.2.2.

### 3.2.2 Starting a New Fermentation.

This option is accessed either as the first option in the **File** menu or the leftmost button on the Toolbar. A "wizard" is then activated which progresses via a series of dialogue boxes. The first dialogue box is, in fact, a selection list showing all the available fermenters installed. Either double-click on the desired fermenter from the list or single-click and press the **Next** button of the dialogue box to proceed. This leads to a second dialogue box, as shown in Figure 3.8.

![Figure 3.8](image)
The dialogue box shows the fermenter name and below it the fermentation title. Here you can enter a name for the fermentation (a default is selected otherwise). The file name will have the .iri extension added and it can be any valid name which Windows will accept. Note, if possible it makes sense to stick to 8 character file names in case you wish to manipulate the fields under DOS for any reason.

The Initial phase combi box allows selection between inoculation or fermentation for Sixfors and Labfors with sterilization included as a third option for Techfors and larger fermenters.

**Fermentation** is the option to choose if the fermenter is to be used immediately.

**Inoculation** allows logging to be displayed from the time an inoculum of culture is added to the fermenter vessel as well as the time the fermenter was actually started. When the inoculum is added, the time is flagged using the Fermenter Options menu and clicking on Innocluate. A confirmation message box appears with the inoculation time. Click OK to continue. This option is only available **when the fermenter is active**.

**Sterilization** offers a different set of options with the chance to set temperature, speed and sterilization duration on a special dialogue box with the relevant text edit boxes to be completed before proceeding. Sterilization is started, stopped and edited via the Fermenter options menu **when the fermenter is active**.

The next option is to browse for **Recipe information**. This has the same effect as using the Open option in the file menu. A standard file selection window appears with a list of all the *.iri files available. Single click on the file and then the Open button of the file selection window (or just double-click on the file itself) to move on. A new dialogue box appears in this case showing details of the file and a list of the parameters used. Here you have a button for "Open as receipt" (recipe) if you wish to make setup more automated.

Assuming you leave the Recipe information text box blank, press the Next button to proceed.

The next part of the setup "wizard" is the Fermenter Parameters selection dialogue box.

All the parameters available to the chosen fermenter are displayed in a "pick list" on the left hand side of the screen. A box on the right-hand side accepts selected parameters to be used in the new fermentation.

Movement from one side to the other is made using the ">>" or "<<" buttons with the "All>>" and "<All" buttons for rapid selection of the entire list.

The selected parameters can be edited at this stage by clicking on the chosen parameter to select it (highlights in blue) and press the Edit button. This leads to the parameter editing dialogue box which will be described fully in Section 3.3.3. Click on Next to continue.
The Fermenter Control dialogue box is the final one before the fermentation starts.

Here a batch ticket can be selected from an existing *.bch file for the new fermentation (see Section 3.1.17).

A control sequence can be loaded and then edited by clicking on the Browse button and selecting the desired file from the list of *.SEQ files shown. For details see Section 5.2.

The Follow file area allows existing *.iri file to be selected using a standard file selection window.

When the selected file is opened, a list of parameters appears on the “real param” side. Clicking on any of these parameters opens a Follow parameter selection window listing the selected parameters for the new fermentation. Click on the desired parameter then click on OK for this parameter to be “matched” for following (see Figure 3.10). Follow file is discussed in Section 5.3.

When all your selections are made, click on Finish for the fermentation to start. At any stage, you can go Back, Cancel the whole operation or get Help by clicking on the relevant button.

3.2.3 Opening an Existing Fermentation

This is the second option in the Files menu and allows an archived file to be used as a template for (or even be overwritten by) a new fermentation. The Open option leads to a sub-menu where Open is again an option. This leads to a standard Windows file selection window (Figure 3.11) which, by default, only shows *.iris files. Clicking on the file then the open button leads to a standard Windows File Selection (Open) dialogue box where the only options (at this stage) are to Open as Receipt and Cancel if you find your selection is incorrect. Opening the file then takes you into the Setup Wizard with the Recipe information area of the Fermenter Startup dialogue box completed with the filename of your selected fermentation. The type of fermenter which is selected defaults to the type used to create the recipe file in the first place (unless it is already in use, in which case the normal fermenter selection dialogue box is opened).
3.2.4 Altering What is Displayed
The main IRIS window consists of

a) **Menu** bar (which cannot be removed).

b) **Toolbar** which has a number of shortcut buttons (some greyed out and unusable before a fermentation is started).

c) **Status Bar** which shows important information such as the current sequence and the function of specific buttons.

d) **Alarm View** which is a resizeable (and closeable) window giving details of all alarm messages generated by the active fermentation. Clearly, the window is blank before a fermenter is started.

Options (b) to (d) can be displayed or hidden using the **View** menu. By default, all options are active. To deactivate, click on the option to be removed. The tick by the option will disappear. Click on it again to reactivate.

3.3 Parameters of Iris
IRIS can be used for a number of different types of variable beyond the simple process parameters which can be measured by the fermenter instrumentation. The various parameter types are:

a) **Measured**
These are the classic parameters measured by probes and sensors within the fermenter vessel. They have a number of settings which can be changed as discussed in Section 3.1.7

b) **Analysis**
This parameter needs fewer fields to define it than does the measured type, and they have the same meaning as those above. The one exception to this is that the user can edit the value field of an analysis parameter, either from within the main IRIS program or from the History Viewer (IRIS-Pro). Analysis values are entered at the keyboard and typically result from off-line analyses performed on samples taken from the fermenter vessels at intervals.

c) **Calculated**
Although not measured, this parameter type does have values which may change constantly (generated by the control language). Therefore, it has logging rate values. All of the other fields have the same meaning as they do for a measured parameter.

d) **Analog Pump**
This has a definition which is similar to measured. The major difference is that there are no alarm regions.

e) **Digital**
This is similar to Analog pump except that there is no calibration information.

f) **Balance** (special option)
This class of parameter is used when very accurate measurement of the amount of reagent (acid, alkali, antifoam, feed) added to the fermenter vessel is needed. Certain balances can transmit data via a serial communications port which can be used by IRIS.

g) **Gas Analyser** (special option)
Analysis of the exit gas from a fermenter to measure the Carbon Dioxide evolved versus the Oxygen used can give a measure of the metabolic activity of the culture (Respiratory Quotient - RQ). Mass Spectrometers usually measure these values and send data via RS232.
3.3.1 Adding Parameters

This is the first available option in the Parameters menu and leads to a sub-menu listing the 7 types of parameter described in Section 3.1.6. Any of these can be selected but it is sensible to use a measured parameter as an example as this includes the most options. A basic range of parameters will be installed by IRIS by default and you can add to these as required.

Click on Add Parameters and then pull across and click to selected Measured. The Edit Measured Parameters dialogue box is activated.

![Edit Measured Parameters](image)

Figure 3.12

Not every option applies to every fermenter type or parameter option. A comprehensive list of the choices for a Measured Parameter is given below, grouped as they appear on the screen:

3.3.2 Parameter Data Parts in Detail

a) **Param Type:** This is predefined by your previous selection and cannot be altered. It should have in the value field the title 'Measured'.

b) **Param Name:** This is the name that you will use in the selection operations and will appear on all printed reports. Enter the name you require for this variable (eg pH). We would advise that parameters are identified as belonging to a particular fermenter ie. name parameter pH1 to indicate that it is from fermenter 1, pH2 for fermenter 2 etc. Adding a * character after a parameter name makes it available to all the installed fermenters. Adding a „mask” character i.e. the fermenter number, makes that parameter specifically for use with the fermenter having that „Select mask” eg. Flow1 reserves Flow for fermenter 1.
c) **Units**: This is the name of the engineering units we wish to give to this parameter. It will show up on reports and graphs eg. rpm, pH L/min.

d) **Max Value**: This is the maximum value that this particular parameter can possibly have. Do not make this value too small because any value measured past this will be rejected as an error. If you make the value too large then you will lose resolution in your graphical reports.

e) **Min Value**: This is the minimum value you will possibly expect to be read for this value. The same warning applies as above.

f) **Value**: This is not alterable by the user. During a fermentation this the parameter editing screen is used as a parameter view screen and then this field holds the current value being monitored from the fermenter.

Logging:

g) **Disk log**: This is an ON/OFF field that specifies if a variable's information should be written to disc or not. If this field is set ON the parameter value will be logged.

h) **Filtering Level**: If filtering is enabled, this field decides the extent. The value should be between 0.00(minimal) and 1.00(maximum). Only for type ISF fermenters. The calculation behind is:
\[ \text{LOGGED\_VALUE} = \frac{(\text{NEW\_VALUE} \times (1 - \text{FILTER\_LEVEL})) + (\text{OLD\_VALUE} \times \text{FILTER\_LEVEL})}{2} \]

i) **Spike Rejection Level**: This field sets the spike rejection level and is the actual absolute difference in value beyond which the newly acquired data will be rejected. Only for type ISF fermenters.

j) **Log Difference**: This field contains a value in parameter units. When the parameter changes in value from its last log by this amount or greater then a log occurs eg. 0.5 for +/- half a pH unit. As a rule 1..5 % of the range of a parameter is a good value.

k) **Log Rate**: IRIS uses a system of both logging by time and by difference. The Log Rate field gives the intervals in seconds between each log of data eg. 600=once every 10 minutes. We advise 60 .. 600 s as a good value.

Recalibration:

l) **Recalibrate incoming values**: A tick box which determines if an incoming value will be adjusted according to the values set in the associated value boxes. This can be used to readjust values. Pump timings can be recalibrated to display ml or g instead of seconds that come from fermenter.

m) **Slope**: This field contains information from the calibration routine. When a parameter is being created this defaults to 1.0.

n) **Offset**: This field contains further information about calibration data and defaults to a value of 0 when the parameter is first created.

Graphics Options:

o) **Colour**: clicking on the default colour leads to a pallette where a new colour can be selected. This colour is used for graphical displays such as the On-line graph.
Input/Output Data:

p) Input Channel: This field defines the location of the measurement value as a channel of the instrumentation of the fermenter. It is usually set at installation and should not be changed (See chapter 2).

q) Output Channel: This usually should have the same value as the input channel. This field defines the location of the measurement value as a channel of the instrumentation of the fermenter. It is usually set at installation and should not be changed (See chapter 2).

r) Setpoint remote: This is an on/off field which determines if IRIS will send control values to the fermenter.

s) Sensor Data: This is an ON/OFF field which indicates if the value that is to be read and logged should come from the defined input channel or if IRIS should use the backup value instead. If this field is ON then the data comes from the fermenter, otherwise it comes from the backup value. The backup value is logged to file but the record is „marked“.

t) Backup Val: This is to allow the operator to enter sampled readings as the value instead of the automatic reading. This is useful when a probe fails but a record needs to be kept.

Limits:

u) Upper Critical: This is a value field which defines the upper band in IRIS’s five band limit system. If the measured parameter value reaches or exceeds this limit then an alarm condition occurs which the fermentation may act upon as required. This critical alarm is recorded and reported. This value must be greater than the Upper Alarm limit and lower than or equal to the preset maximum. Right-hand Red Line on Bar display

v) Upper Alarm: This field decides the bottom of the upper alarm region. If the parameter value is greater than or equal to the value then an alarm condition holds. This is recorded and reported and may be acted upon by the fermentation. This value must be greater than the set point value. Right-Hand Yellow Line on Bar Display

w) Set point: This is the value that is sent to the INFORS fermenter and used in the control function as the required set-point value. It is also used to determine the alarm values and display colours. This value must be greater than the lower alarm limit. Green Line on Bar.

x) Lower Alarm: This field determines the upper limit of the lower alarm region. If the parameter value is less than or equal to this value then the parameter is in the lower alarm region. This state is recorded and reported. This value must be greater than the lower critical limit. Left-hand Yellow Line on Bar Display

y) Lower Critical: This field determines the upper limit of the lower critical region. If the parameter value is less than or equal to this value then the parameter is in a critical alarm state and this is recorded and reported. This value must be greater than or equal to the preset minimum. Left-hand Red Line on Bar Display

Alarms:

z) Log on Alarm: This is an ON/OFF field that determines if a value will be logged if it strays into an alarm region. If this is ON then logging in alarm regions is enabled and takes place at a fixed interval of every second.

aa) Alarm delay: This is a value field which specifies the period (delay) in seconds between a parameter being reported as in alarm and the next time that it can again be reported. This is to stop a continuous stream of reports if the value is in an alarm state.
Analysis values have a very simple subset of the measured values options as no physical data channels and alarm limits have to be set.

Calculated values have a similar structure to measured parameters except for channel allocation.

Alarm limits have to be set as IRIS treats a calculated parameter exactly the same way as a measured value for logging and control purposes.

Pump settings are again similar to those for measured parameters, and in this case channel allocation is important but alarm limits are not.

Typically, analogue pumps have output values but do not generally require data-logging.

Other special options such as Gas Analysers and balances, which are dealt with separately as the requirements vary according to manufacturer and number (i.e. if a switchbox is required). Example configurations are available on request/included in the appendices according to the original specification of the system ordered from Infors.
3.3.3 Editing a Parameter
Choosing the Edit option from the Parameters menu leads to the following dialogue box:

This allows selection of an individual parameter by clicking on it and then using one of the four option buttons associated with that parameter:

Edit leads to the same dialogue box described in Section 3.1.7. The edit Parameter dialogue box is, of course, appropriate for the type of parameter selected.

Copy leads to the same dialogue box but allows a new parameter to be created by editing the information for the selected existing parameter.

Delete will remove the selected parameter from the list (with a final check that you really do wish to do this).

Calibrate is only relevant at the moment only ISF fermenters can use this but it is not implemented at the moment.

Close can be used without selecting a parameter and returns you to the main IRIS window.

A Quick Edit screen is available when a fermenter is active for rapid alteration of set points etc.

3.3.4 Calibration of a Parameter

A parameter must be calibrated on the fermenter except for ISF fermenter with timer interface. To calibrate the parameter the user must first start a fermentation or have a fermentation running on that fermenter. The TEXT OVERVIEW must be active. The parameter that needs calibration must be selected (click on it with the mouse). Now you can start calibration. The Menu Parameters->Calibrate is now selectable. The Parameter calibration menu appears.

To calibrate you first give in a lower value and check the read ADC checker in the `Low point` section. The Reading will now automatically be updated. When the Reading has stabilised and looks ok uncheck the read ADC cheker. This stops updating of the Reading field. The reading field can be edited by hand if necessary.

Now you can do the same thing in the `High point` section. Please make sure that High point and low point values are not the same.
As soon as Low and High point are fine click on 'Apply calibration' button. This will make automatic calculation of slope and offset. Enable calibration is to use the new values of slope and offset. This is the same function as the 'Recalibrate incoming values' checker in parameter screen. If this is checked possible to see actual calibrated and updated values if the 'calculate' checker is checked.

3.3.5 Fermenter Options

The Fermenter menu provides access to only the Edit function at this stage and this, in turn, leads to the following Select fermenter dialogue box:

The fermenter to be "edited" is selected by single clicking to highlight it in blue.

Selection leads to the Fermenter Properties dialogue box first used as part of the setup procedure described in Section 2.2.2. (Figure 2.2.).

It is now appropriate to make a feature-by-feature list of the various options which can be set:

Table 3.1. Options for fermenter Properties

<table>
<thead>
<tr>
<th>FERMENTER DEFINITIONS</th>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ferm. Name</td>
<td>Techfors</td>
<td></td>
</tr>
<tr>
<td>Schema file</td>
<td>Labpres.bmp</td>
<td></td>
</tr>
<tr>
<td>Device Model</td>
<td>SDDC</td>
<td></td>
</tr>
<tr>
<td>Selectable</td>
<td>ON (tick)</td>
<td></td>
</tr>
<tr>
<td>Sterilizable</td>
<td>ON (tick)</td>
<td></td>
</tr>
<tr>
<td>Closeable</td>
<td>ON (tick)</td>
<td></td>
</tr>
<tr>
<td>Port</td>
<td>COM 1</td>
<td></td>
</tr>
<tr>
<td>Seq. on Inoc.</td>
<td>After Inoc.</td>
<td></td>
</tr>
<tr>
<td>Switch No.</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Ferm Code</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Pass. Level</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>MS Inlet</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Select Mask</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Follow time</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Def. Title</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Def. Sequence</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Def. Recipe</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reject 1st. Alarm</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

a) **Name** is used to identify the fermenter. This name must be same as that used in other equipment to which IRIS is linked. For example a mass spectrometer gas analysis system.

b) **Schema file** can be assigned individually to each fermenter to allow for customised overviews.

c) **Selective** is set OFF (no tick) then the fermenter cannot be selected for startup etc. This is a way of preventing someone starting a fermentation on a faulty or reserved fermenter.

d) **Sterilizable** must be set ON (tick) for a fermenter to be sterilized automatically under the control of IRIS. It is possible to mix the types of fermenters used with IRIS, for example two may be Techfors, 3 may be Labfors and one may be BioStat E.

Only the Techfor's would be autosterilizable and so setting this option OFF for the others prevents the operator from mistakenly attempting to sterilize a non-sterilizable fermenter.
e) **Device Model** refers to the type of fermenter instrumentation. This MUST be set correctly for communication to take place. See Section 2.2. for details of this selection.

f) **Port** is the serial communications port to which the fermenter is connected. Again, part of the initial setup procedures and not to be altered unless you change the computer or fermenter configuration.

g) **Closeable** allows you to prevent premature closedown of a fermenter.

h) **Seq. On Inoc:** This is set when the default sequence (if any defined) will be activated:

- **Immediate:** immediately
- **Before Inoc:** Control language is already active during the holding phase (will start at the end of the initial sterilisation)
- **After Inoc:** Control language will be active when the fermentation is started

i) **Switch number** is important, and can vary according to the type of fermenter used. See Section 2.2. for detailed explanations.

j) **Pass level** allows you to set an access right to a fermenter so that only certain fermenters can be accessed by certain users.

k) **MS Inlet** must be correctly filled if you are using a Mass Spectrometer. It sets the Inlet number on the MS, from where the fermenter gas samples are taken for analysis.

l) **Select mask** is a method for tying variables to fermenters. When a fermenter is selected and then the parameters to used with this fermenter must be chosen, IRIS generates the parameter list by looking for the select mask value in the parameter name. Setting this value to blank means no mask and all parameters are selected. See Section on 3.1.7 for more information.

m) **Follow time** is used when you wish to perform a sequence of fermentations with certain parameters kept at identical values (see the section on FOLLOWING for further details). This value allows you to set the closeness of the follow. It value ranges from 10 upwards in seconds. Do not make this value too small because the system response will slow dramatically.

n) **Default title** is used if you want apply the same title to all the fermentation of the selected fermenter. The title is used to set the file name (for example from the title "test" the fermentation file name will be "test0000", "test0001", etc.).

o) **Default sequence** field if you always need the same sequence. See Section 5.2. for more details about sequences.

Type the **recipe** name if you want to start a series of fermentations using the same configuration. When starting a fermentation you will not have to fill in the recipe section.
3.3.6 Sterilization Options

Prior to starting a fermentation, the sterilize options on the fermenter menu are „greyed out” and not available. However, as part of the Start (New fermentation) wizard for an in-situ sterilizable fermenter such as Techfors, there is an option in the Initial Phase combi box to select the choice of Sterilization.

Clicking on Next leads to the dialogue box opposite instead of the parameter selection list which is normally displayed next.

Here the temperature of sterilization, the speed of the stirrer during sterilization and the duration of time at the sterilization temperature can all be entered on the text edit boxes.

The inoculation temperature is the final operating temperature of the fermenter post-sterilization.

The Save Default button allows these choices to become the defaults. Click on Next to proceed as normal.

When the fermentation has started, the Fermenter menu options for sterilization become available.

3.4 Passwords & Logging In

Every user of the IRIS system should have an individual Password for access to the program. On installation, a “default user” is created and they are always logged in by default whenever the IRIS main program is started. If security is not an issue, this arrangement is all you need to use the software successfully.

However, if you need to ensure only the right people gain access to the system, you will need to know how to assign and administer passwords, users, and access rights. The next three sections will explain these features.

Logging in with your password is achieved using either the Password menu, Log in or by pressing the Password key on the toolbar:

Your user name will have been entered by the administrator and you must now enter this into the relevant text edit box followed by your password in the lower box.

Press OK to gain access to the system.

Any normal alpha-numeric characters are acceptable and the art is choosing a combination which you can remember but is not too easy for others to guess.
Changing a password is possible using the second menu option. First enter your name, and your old password is requested. Enter it. If your identification is accepted, you are asked to enter a new password, and then re-enter it (to avoid accepting a typing error as the password).

Of course, you must have an access level appropriate to being able to change your password for this function to be available. Changing your password on a regular eg. monthly basis is advised.

The **Login default** option of the **Passwords** menu will tell you the default user is already logged in unless you have altered the standard installation condition. However the default user should not have a low level otherwise the system is not protected if the default user is logged in. If you forget your passwords you need to reinstall the files wiris.ups, wiris.rgt and levels.p. Like that all your changes are deleted.

### 3.4.1 Users

This part of the **Passwords** menu allows you to set up who has access to IRIS and which features of the program you can use. Selecting **User** leads first to a selection window with a list of available users:

**Add user** leads straight to a further dialogue box for entering information about that user.

For **Remove user** and **Edit user**, click on the required individual’s name to highlight it in blue first and then click on the appropriate button.

No additional confirmation is necessary to remove a user. Click on **OK** to continue.
For Adding or Editing a user, the **User info** dialogue box is activated

![User info dialogue box](image)

In the **User info** section a name must be provided along with a password which has to be confirmed by repeating it (to prevent a user being “locked out” by a typing error on first entering the password). This information MUST be completed or you can only leave the dialogue box by clicking on **Cancel**. An optional description of the user can be given eg. “Experienced technician”.

On the right-hand side of the screen is a list of all the major functions of the IRIS program with a number against them between 0-250. The more critical a function, the higher is its number. A **User level** is assigned by entering a number which allows that individual access to some features but not others depending on their seniority, experience or involvement with the work in progress.

An **Action log** can be created for that user which will record all their actions while they are logged into the system (useful for training and security) but can create large log files on your system. The action logging writes the file usrlog.txt. If you use this feature you should backup and delete this file regularly. Click on **OK** to continue.

### 3.4.2 Defining Levels of Access Rights

![Change WIRIS access levels](image)

**Define levels** is the last option of the **Password** menu and lets you determine what importance to assign to individual features within IRIS from an “access level” viewpoint.

The **Change WIRIS access levels** dialogue box shows a list of features each with a number between 0 and 250, identical to the one shown in the change user dialogue box described in Section 3.1.12.

In this case, you can actually edit the number (or “access level”) assigned to each feature by clicking it to select and then editing the number in the text edit box **Level** at the lower left of the screen.

The **Level description** can also be edited.

The higher the number, the more restricted access should be to that feature with the very highest reserved for the system administrator.

Click on **Apply** for the desired change to be made and **OK** to edit the dialogue box.
A detailed explanation of access rights and their relationship to users is given below:

**Access level**  |  **Significance**  
--- | ---  
0 | No access permission required, any user, authorised or not can have access.  
1..255 | A password is requested and only those users with sufficient rights (ie an access right equal to or greater than the function access level) can use the function.

To show how this system works, consider a simple system with three users A, B and C. A is declared as the administrator, B is a senior technician and C is a laboratory assistant. They may have the access rights shown in table 3.2.

<table>
<thead>
<tr>
<th>USER</th>
<th>ACCESS LEVEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>250</td>
</tr>
<tr>
<td>B</td>
<td>200</td>
</tr>
<tr>
<td>C</td>
<td>100</td>
</tr>
</tbody>
</table>

*Table 3.2*

Now consider five functions used within IRIS and assume that they have the access levels shown in table 3.3.

<table>
<thead>
<tr>
<th>NUMBER</th>
<th>FUNCTION</th>
<th>ACCESS LEVEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Startup</td>
<td>150</td>
</tr>
<tr>
<td>2</td>
<td>Closedown</td>
<td>190</td>
</tr>
<tr>
<td>3</td>
<td>Calibrate</td>
<td>90</td>
</tr>
<tr>
<td>4</td>
<td>Delete parameters</td>
<td>210</td>
</tr>
<tr>
<td>5</td>
<td>Closedown</td>
<td>250</td>
</tr>
</tbody>
</table>

*Table 3.3*

This part of IRIS is critically important for many industrial users where authorisation and validation are everyday aspects of fermentation work.
3.5 Devices

This is the first option in the Extras menu and deals specifically with the serial communications between types of Infors fermenters and the computer. This topic has been dealt with in Chapter 2 but a detailed description of the various options is provided here:

Figure 3.24

Figure 3.24. Is a combination of the Devices dialogue box seen in Figure 2.1 and the secondary Comm settings options which appear when the Settings buttons next to each listed Com port is clicked.

Devices lists the four standard com ports normally found on a PC - Com 1 - Com 4. It may be that Com1 is, for example, already used to connect your mouse. To avoid conflicts, the option for Com1 must be set to None in that case. Any unused com port should also be set to none (the default).

The alternative options are:

a) SDDC This is the most flexible option and is certain to be correct for all new installations when used with IRIS-PRO.

b) ISF This is used for Infors equipment with analogue (type MRR) instrumentation and a separate timer/interface module. These fermenters need the calibration options.

c) Labfors This can, in fact, be used with both Labfors 1 and 2, Minifors and Sixfors fermenters which do not support the SDDC option (used with Labfors 3, Techfors S and Techfors).

The settings for each Com port allow adjustment of the serial communications protocol:

Baud rate alters the speed of data transfer - the default of 9600 should be used whenever possible although higher rates are supported.
**Parity** A technical description is not the function of this manual, suffice it to say that it is a none too reliable mechanism to detecting transmission errors. It can be set to a number of possible values.

<table>
<thead>
<tr>
<th>Parity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None:</td>
<td>This is a surprisingly common setting.</td>
</tr>
<tr>
<td>Even:</td>
<td>Ensures an even number of 1 bits sent.</td>
</tr>
<tr>
<td>Odd:</td>
<td>Ensures an odd number of 1 bits sent.</td>
</tr>
<tr>
<td>Mark:</td>
<td>Parity bit is always set to 1</td>
</tr>
<tr>
<td>Space:</td>
<td>Parity bit is always set to 0</td>
</tr>
</tbody>
</table>

*Table 3.5*

**Data bits.** This is the number of bits which are used to define a character to be transferred. This has possible values between 5 and 8 with 8 being the most common value. Satorius balance/pump systems uses a 7 data bit size.

**Stop bits.** This is the number of bits appended to the end of the transmitted character so that the RS232 receiver detects the end of a character. This is usually 1, 1.5 or 2 bits. Most commonly used are 2 or 1.

Combi boxes provide a drop down list of possible options for each of the settings.

Unless you are adding IRIS to an existing installation, these settings will be configured on installation and should not need changing unless the use of the system also changes eg. adding extra units.

### 3.6 Special Functions

These are system-wide options which really do not fit into any of the previous categories. They are accessed using the final choice in the **Extras** menu and lead to the **Special Options** dialogue box.

**Alarm repeat delay** is the period between an alarm message being given and it being repeated if no significant change in the parameter value occurs. The time should be long enough to allow for. Eg. mixing of reagents to provide remedial action.

**Autosave Period** is set to prevent large amount of data being lost between disk logging periods if a catastrophe should befall the computer eg. a power failure. Iris keeps new data in the RAM and saves it at this intervall. Times between 600s (10mn) and 1800s (30mn) give best results.

**Iris system directory path** refers to the location on your hard disk where IRIS will expect to find its various configuration files. This should normally be left blank to retain its installation default value or it may not be possible to use IRIS properly. If you want to use a other path for datalogging the Iris system path has to be set to the actual path of Iris.exe. You can use the "...." button to find Iris.exe on your system.

The **Screensaver lock** is for all user that use the password system after the set time the default user is automaticaly logged in and your system is protected also if you forget to log out.

---

**Figure 3.25**
3.7 Windows Options
These are standard windows options and are included for completeness.

The options are a) **Cascade**, where each active window is “stacked” one behind the other (default).

b) **Tile**, where active windows are side by side

c) **Arrange icons** allows icons associated with the active windows to be lined up at the bottom of the window.

After this, a list of windows is shown with a tick by the one which is currently active.

By opening the IRIS window to full screen, then resizing the open windows by dragging the corners of each one in turn, it is possible to get 4 different text windows displayed at the same time without overlapping.

3.8 Making a Batch Ticket
This section is included in the off-line options as the file name for a batch ticket will normally be selected as part of the Startup options. It is not necessary to make a batch ticket but it does allow a great deal of additional information to be stored with the logged data which may be necessary for validation or protocol purposes.

No editing of the batch ticket can occur until the fermentation has started and there is also the chance to prepare a new batch ticket at this stage if the option was not chosen during startup.

A blank **Windows Notepad** window appears which has the file name of the active fermentation plus the `.bch` file extension. Using standard **Notepad** functions, it is possible to create a batch file with information similar to the example shown below:

<table>
<thead>
<tr>
<th>Infors AG</th>
<th>REPORT DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fermentation Title:</td>
<td></td>
</tr>
<tr>
<td>Fermenter ID code:</td>
<td></td>
</tr>
<tr>
<td>Fermentation code:</td>
<td></td>
</tr>
<tr>
<td>Batch ID code:</td>
<td></td>
</tr>
<tr>
<td>Experiment ID:</td>
<td></td>
</tr>
<tr>
<td>Organism Id:</td>
<td>Supplier:</td>
</tr>
<tr>
<td>Culture from:</td>
<td>Age:</td>
</tr>
<tr>
<td>Media ID Code:</td>
<td>Supplier:</td>
</tr>
<tr>
<td>User:</td>
<td>Contact No:</td>
</tr>
<tr>
<td>Comments:</td>
<td></td>
</tr>
</tbody>
</table>

Table 3.6
3.9 On-Line Options, IRIS main Program.

3.9.1 Menu Options & Toolbar - Changes from Offline

This section will deal with new menu options and other features which are only available when a fermenter is active and “on-line” to the main IRIS program. Therefore, descriptions of menu options and toolbar buttons not covered in this section will be found in Section 3.1.1. If the active window is the alarm window the menus are in the `offline version`. Most of these options are described in Section 3.1.1. The new features available for active fermenters are:

**Save.** This saves the current fermenter file to disk with the file name you chose when it was set up.

**Save as...** Leads to a standard Windows file selection/save dialogue box allowing the file to be renamed before saving.

**Print Preview** is only active when the Schema or On-line Graph views are in use. It leads to a new window with various display options relating to how the chosen view can be printed.

**Print** leads to the standard Windows dialogue box for printing. It is only active for Schema and On-line Graph views.

The **Edit** menu option only appears when a fermenter is active. It allows access to sub-menus for the creation and editing of Batch tickets and Control Sequences.

Options for **Batch ticket** are **Edit current** and **Create new**.

The options for **Control Sequence** are shown in Figure 3.27.
The View menu contains new options relating to which type of display of the live fermentation data is required:

**Text overview** is a simple table of data about current value of a parameter, its setpoint limits etc.

**Online Graphics** is a display similar to the output from a chart recorder.

**Schematic View** is a pictorial representation with parameter information boxes overlaid onto the chosen bitmap image.

**Bar View** is similar to the display provided on industrial Programmable Logic Controllers with moving coloured bars indicating value, alarm limits etc.

**Drag View** (greyed out initially) allows the view of the graph to be moved in two dimensions as a window on a chosen part of the graph.

**To Centre** (greyed out initially) takes the view to the centre of the graph.

**Zoom In** increases the "magnification" of the view of a graph, up to a resolution of single minutes.

**Zoom Out** decreases the "magnification" of the view of a graph.

**Zoom area** allow selection of a rectangular window to be zoomed.

**Data Cursor** shows cross-hairs which can be used to accurately select a given point.

**Zoom in time axis** allows increase of the resolution of the time base while leaving the parameter axes unaltered.

**Zoom out time axis** allows decrease of the resolution of the time base while leaving the parameter axes unaltered.

**Automatic Zoom to Fit** allows all the data to be shown in one screen without scrolling.

**Follow mode** is used to create a display which can scroll backwards to give a "chart recorder" display where the most recent part of the graph is always shown.

**Properties** leads to a dialogue box where many different options relating to the graphical display can be set: Colours for background, grid and axes, the font used, single or multiple x axis etc.

The Parameters menu remains the same and is described in Section 3.1.1.

The Fermenter menu has a number of new options available. If the fermenter was starting in Inoculate mode the first menu option **Inoculate** is used to indicate the moment when the culture is added.

**Sterilize** leads to a sub-menu to **Start** a sterilization or **Edit** an existing one. **Quit** is only active if the sterilization process has already started.

**Sterilize/Close** is an option allowing sterilization before closedown (useful for pathogenic or genetically altered culture). When this is chosen Iris will closedown the fermentation (and the document) as soon as the fermenter reaches the end of the sterilisation.
Parameter settings activates a dialogue box for selection and editing of parameters while the fermenter is active. It is also possible to add new parameters at this stage.

Fermenter settings leads to the Fermenter Properties dialogue box shown in Figure 2.2. If the user wants to select the fermenter (settings of other than the actual fermenter should be changed) he has to select the alarm window as active window.

The Passwords menu does not change.

<table>
<thead>
<tr>
<th>Extra</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Devices</td>
<td>Statistics</td>
<td>Fermenter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Balance</td>
</tr>
<tr>
<td>Password</td>
<td>Specials</td>
<td>Mask Spec</td>
</tr>
</tbody>
</table>

The Extra menu now has an additional option available in statistics (the other options are available if the devices and drivers are installed).

The Fermenter option leads to an information box where the progress of the communications between IRIS and the fermenter can be viewed. This is useful for troubleshooting communications problems.

Other menu options are unchanged.

The following toolbar buttons are now available (depending on other options chosen)

- Open a New fermentation file
- Open an existing File
- Save the current fermentation file
- Inoculate the fermenter (only available if Inoculation mode selected at Startup)
- Text mode display of live data
- On-Line Graph display of data (also illustrates how a selected button is shown). Adds toolbars.
- Schema display of live data
- Bar display of live data
- Password this changes active user to default user (logout of actual user)
- Print (only available for on-line graph and schema displays)
- Help
- Context help

The status bar at the bottom of the active IRIS window displays alarm and information messages, the fermenter number, sequence number and the time the fermenter has been in that sequence (seq-time). A standard Windows hatched area in the bottom right of the screen is used for resizing the window by dragging.
All subsequent sections will make the following assumptions:

1. All required parameters are defined (Sections 3.2.1 and/or 3.2.3)
2. Any necessary calibrations are done (ISF series instrumentation only Sections 3.2.4).
3. The fermenter(s) are prepared to start (see the relevant fermenter/instrumentation manual)
4. Check all cables are correctly inserted.
5. You have followed a startup procedure for your chosen fermenters as described in Sections 3.1.2 or 3.1.3

3.9.2 Changing the View of On-line data

IRIS is very flexible in the way live data can be displayed. Irrespective of your selected logging rate to disk, the IRIS display is updated every few seconds for each active fermenter. The default view is the **Text screen**.

**Figure 3.31**

The blue title bar of the active IRIS window shows the file name and current fermenter condition.

The text view display has two distinct areas. At the top of the screen is important information about the fermentation such as its current **Fermenter No.** (0), **Phase of operation** (FERMENTING in this case) and **STATUS** (Normal), **Duration** (00:00:13), **Title** (015), **Params** (5) and **Seq. No.** (1).

The table of data shown beneath is laid out for each chosen parameter as follows:

- **Name**: The parameter name.
- **Unit**: The engineering units used to define that parameter=s value eg. r.p.m. or %.
- **BkUp**: This column shows two important characteristics of the parameter - if it is a Backup rather than a real value (Bk) and if it is under remote control (Co).
- **Value**: The current value for the parameter, expressed in its selected units.
- **Setpoint**: The remote setpoint selected for that parameter.
Min: The minimum value the parameter has been for the duration of the fermentation.

Max: The maximum value the parameter has been for the duration of the fermentation.

Status: The current alarm status of the parameter (Normal, High/Low Alarm or High/Low Critical)

The min. and max. values are useful for determining at a glance eg. if an alarm condition which happened overnight and has subsequently corrected itself was serious or trivial (a look at the Alarms windows next would tell you the duration of the condition).

The values should change slightly every few seconds if the communication between fermenter(s) and computer is working properly.

Analysis and calculated parameters are shown in exactly the same way as measured values.

Single clicking on any parameter then right-clicking will produce a button for Quick Editing (see Section 3.8.4). N.B. double-clicking will activate the Quick Edit dialogue box directly.

Views are most easily changed by pressing the relevant toolbar button (see Section 3.8.1). The next display button in the toolbar sequence is On-Line Graph:

The on-line graphical display is selected in version 5 in the same way as previous version eg. by clicking the graph option button when a fermentation is running.

The display initially looks similar to previous version but new options can be seen in the lower left toolbar area:

A description of each new button is provided below. Please note that some buttons are not active until specific options are first selected.

The options visible by default when the on-line graphical mode is first selected are:
The Autozoom button. This allows the graph to fit the available display area as the time base increases.

The Follow button allows the display to be used like "electric chartpaper". The display always shows the current values and previous data is accessed via a scroll bar. This is the most common method of operation.

Show Guides allows a set of cross-hairs to be superimposed over the graphical data so a clear indication of value and time at any particular point can be made by reference to the axes.

This is the Properties button and leads to a dialogue box for changing options such as colours, lines and backgrounds for graphs. These options are described in more detail later.

This drop-down list shows all the available parameters for the current fermentation. Selection of one leads to a dialogue box and also underlines the name of the chosen parameter on its axis.

De-selecting the autozoom option by left-clicking on it brings the remaining icons into play for selection:

Zoom in time axis - expands the time base but leaves the traces and vertical axes unaltered.

Zoom out time axis - contracts the time base but leaves the traces and vertical axes unaltered.

Zoom Area. Allows a free-positioned rectangular area of the visible graph to be selected for expansion of both horizontal and vertical axes.

Restore full graphics. This negates the effect of any zooming options and allows the original graphical display to be restored. Think of it as a "let's go back to where I started" button.

Zoom IN button. A zoom in cursor is displayed on the screen which can be moved to the area to be expanded and then left click to zoom.

Zoom OUT button. Contacts and expanded area in steps. A zoom in cursor is displayed on the screen which can be moved to the area to be expanded and then left click to zoom out.

Centre cursor. This takes the cursor to the mid-point on the graph of the vertical and horizontal axes of the zomed area shown in the display.
Drag cursor. This allows expansion and movement of the vertical and horizontal axes along the time base when the drag cursor is selected (click and hold to make the hand "grasp" the selected area. Values on the axes expand and change according to the dragging action.

Right clicking on the graph area brings up the following menu:

This menu contains all the options accessed by the various toolbar buttons described above.

The tool Properties option shown highlighted, leads to the choices for changing the appearance of the on-line graphical display.
3.9.2.1 Properties menu and structure.

The properties window provides the tools for changing the appearance of the graph and surrounding axes area, the lines and legends on the graph and the appearance of the traces associated with each parameter. Access to each level of change is controlled from the "tree structure" in the left-hand pane of the properties window.

At the topmost level (generic), the appearance of the background area of the graph is changed. Drop down lists provide colour options for the background to the display window, the viewing area of the graph, i.e., the background of the value traces and the colour of the grid lines. The lower area of this dialogue deals with the size and appearance of any text on the graph, including the opportunity to add a title.

By left-clicking on an individual parameter name, the dialogue for that particular axis appears.

Choices here include:

**Auto format**: This is selected by default and normally does not need changing

**Auto limits**: If selected, this shows the parameter axis as its full range of possible values. If deselected, the range of values shown on the X axis and the steps can be defined in the units of the parameter.

Title font and appearance of numbers when shown on screen and when printed can be selected.
Bound: This drop down list gives the choice of left or right and determines which side of the graph the axis for this parameter will be shown.

Having set the axis appearance for each parameter, clicking on the + box to expand the tree gives access to the options for setting the trace line appearance for that specific parameter:

![Properties](image)

- **Style** changes the appearance of the line from choices in the drop down list e.g. solid, dashed etc.

- **Thickness** changes how thick a trace line is - useful for highlighting one particular parameter.

- **Display Colour & Printer Colour** allow choice of colours when a trace is displayed on the screen and when it is printed.

- **Function & Argument** essentially set what is being displayed by the parameter in terms of the x and y axis. This should not normally be changed.

The tick box for **Visible** determines if this parameter trace will actually be shown on the on-line graph at all. This would usually be left set ticked to allow the line to be seen. With a large number of parameters, not all may be needed on the on-line graph and the unwanted ones can then be removed by unticking this option.

The lower section of the display is functionally identical to the Bar display but with a series of tick boxes along the left-hand side. Clicking on a tick box allows that parameter to be displayed on the graph. Clicking again (so the tick disappears) removes that parameter.

Double clicking or right-clicking anywhere on the bar for a chosen parameter activates the Quick edit parameter context dialogue box.

The **Bar** display shows the following information for each parameter bar. The columns of information
surrounding the bar are the same as those described for the Text view.
A new option is the Color button which shows the selected colour for the chosen parameter.

The next type of display is the Schema view.
This display allows parameter “boxes” to be displayed against a bitmap background of your choice.

The bitmap used and the parameters displayed can be selected by using a context dialogue box activated by right-clicking anywhere on the background.

The Add Parameter option leads to a sub-menu where all the parameters for the current fermentation are displayed. They can be selected one at a time by clicking on them in turn. At this point the relevant box is added to the display.

Select background leads to a standard Windows Open dialogue box where only bitmap files are displayed for selection. A number of these are provided for you. It is possible to create your own but start by loading one of our bitmaps into your paint program to match your bitmap size and colour depth to the ones we use.

The small dialogue box shown by the Stirrer parameter in Figure 3.41 is activated by right-clicking on the parameter box. It provides options for Editing the parameter, Deleting the box and altering the Properties of the parameter display:

The View options are set with tick boxes and allow you to choose what information is placed in the parameter box and if the box will have a black border around it.

Font size allows a selection between 3 fixed sizes (the default is Small, Large is shown in Figure 3.35).
The Alarm colors tick box determines if a parameter box is coloured according to its current alarm status (green, red or yellow) or its default of the parameter colour chosen when the parameter was created.

Boxes can be moved around over the background picture by clicking on them and holding the left mouse button down while dragging the box to the desired position on the screen.

The final type of real-time display of fermenter data is the Bar view. This view is similar to the bottom part of the On-line graphical display. The parameter Name is shown before the bar with columns for Value, Setpoint, Unit and Status.

The composition of the bar display is illustrated in Figure 3.43.

<table>
<thead>
<tr>
<th>Name</th>
<th>Bar</th>
<th>Value</th>
<th>Setp</th>
<th>Unit</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp1</td>
<td></td>
<td>35.0</td>
<td>35.0</td>
<td>°C</td>
<td>Normal</td>
</tr>
<tr>
<td>Stress1</td>
<td></td>
<td>540</td>
<td>560</td>
<td>rpm</td>
<td>Normal</td>
</tr>
<tr>
<td>DO2%</td>
<td></td>
<td>-4.0</td>
<td>5.0</td>
<td>%</td>
<td>Do Critical</td>
</tr>
<tr>
<td>pH1</td>
<td></td>
<td>7.00</td>
<td>7.60</td>
<td>pH</td>
<td>Normal</td>
</tr>
<tr>
<td>Ei#mass</td>
<td></td>
<td>44.9</td>
<td>55.0</td>
<td>mg/l</td>
<td>Normal</td>
</tr>
</tbody>
</table>

Figure 3.43

The purpose of this view is to provide a simple graphical indication of status when many parameters must be shown at one time. The display is similar to that used on industrial Programmable Logic Controllers (PLC=s) and based on the same principles.

As a parameter=s actual value deviates from the setpoint a green bar is extended in the direction of the deviation. When it crosses a yellow alarm line the bar colour turns yellow. If a critical limit is breached, the colour turns to red. High and low alarms do not have to be symmetrical.

By glancing at the colour and length of the bars, a quick assessment of a parameter=s status can be made. As a group, the assessment can be extended to the status of the whole fermentation.

3.9.3 Printing On-Line Graphics

The On-line graphical display can be printed either by using the Toolbar Print button or selecting Print from the File menu. This leads to the Standard Windows Print dialogue box where printer properties and number of copies can be set.

Alternatively, you can see what the page will look like before printing using the Print Preview option of the File menu. A new window is opened which allows you to see how the graph as it will appear on paper. The options are identical to those found within Wordpad and so should be familiar.

The On-line graphical display will only print onto one page irrespective of the degree of Magnification with Zoom In. For more comprehensive graphical and printing options, use the History Viewer (see Chapter 4).

N.B. The Schema view can also be printed and this is a copy of the screen display transferred to paper.
3.9.4 Changing a Setpoint

Any of the views of live data offer a rapid way to change the setpoint of an individual parameter (and other properties such as alarm limits) without resorting to the menu bar. In all screens the method is essentially the same:

Right click to activate an Edit button which leads to a context dialogue box for Quick edit parameter (double-clicking on the parameter leads straight to the dialogue box).

![Quick edit parameter dialogue box]

The dialogue box is a subset of the main editing screen for Parameters and is similarly divided up to sections. Many options are “greyed out” and unavailable in this dialogue box.

In the Parameter data section, only the units for the parameter can be changed.

For Input/Output data you switch Setpoint remote On or Off and Sensor data On or Off with the appropriate tick box. If Sensor data if Off (not ticked), a text edit box allows a Backup value to be entered.

The Setpoint / Limits area is the one most likely to be used on a regular basis. It offers text edit boxes for editing the current Setpoint value and the Alarm/Critical limits. Moving the cursor over an “up” or “down” button to the right hand side of each text edit box for the setpoint and alarm limits and clicking will increment or decrement the values accordingly.

A “slider bar” is provided which allows rapid alteration of the set point value by using it as you would a graphics equaliser control on a domestic HiFi. An Apply button will confirm your changes without deactivating the dialogue box if you have further alterations to make.

Finally, the Graphics section has the Color button for changing the display colour for the parameter.

Click the OK button to confirm the changes or Cancel to abort the process and leave all settings unchanged.
3.9.5 Altering Batch Tickets
A batch ticket may have been created as part of the setup procedure or it can be added to an active fermentation file at any time before closedown.

The Edit menu includes a Batch ticket open which leads to a sub-menu for Edit current or Load new.

Edit current provides an opportunity to enter data in a file which was created at setup. The batch ticket system opens the Windows Notepad text editor so all options are standard. What can be included in a batch ticket is covered in Section 3.7.

Load new leads to a standard Windows Open dialogue box with the file type pre-selected as .bch. If you enter a filename which cannot be found, you will be asked if you wish to create a file with that name. This is the way of adding a batch ticket to a fermentation file if it was not created at startup. Choosing a file leads to the standard Windows Notepad screen.

3.9.6 Altering Control options
Control Sequences is the second option in the Edit menu. The range of choices are:

Edit current for changing an existing control sequence already active for that fermenter.

Create new which leads to the compiler text editor window for writing control language sequences.

Load File leads to a standard Windows Open dialogue box for selecting .Seq files. Once opened, the sequence file is available for editing.

When you close the Sequence window, you are given an opportunity to make the sequence active for the current fermenter and to select the sequence number.

Full details of how to prepare control language sequences are given on Chapter 5.

3.9.7 Inoculating a Fermenter
This section assumes that you selected the Inoculate option in the during the startup process rather than Fermentation (see the Initial Phase combi box shown in figure 3.8). When you wish to inoculate the fermenter complete the physical process (see fermenter manual for how to do this) then choose the Inoculate option from the Fermenter menu or click on the Inoculate button on the Toolbar (this looks like a hypodermic syringe).

The time of inoculation is now recorded by IRIS and can be used to set the start of graphs and reports.

3.9.8 On-line Sterilization Options
When you wish to start a fermentation with sterilisation then during startup you select the Initial phase to be Sterilization. This procedure is described in Section 3.1.10. The fermenter must be of a type that is auto-sterilizable (eg. Techfors). You should note that fermenters can be prevented from sterilisation using the Fermenter options dialogue box by making sure Sterilizable is not ticked.

The Sterilization procedure has the following phases:
There are 5 phases of sterilisation shown above. These status of the sterilization is reported in the **Phases** section of the **Text** overview screen. The meanings of the phases are given in table 3.7.

<table>
<thead>
<tr>
<th>Phase</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. WAITING</td>
<td>before start of sterilisation</td>
</tr>
<tr>
<td>2. STEAMING</td>
<td>heating to sterilisation temperature</td>
</tr>
<tr>
<td>3. STERILISING</td>
<td>Fermenter at sterilisation temperature</td>
</tr>
<tr>
<td>4. COOLING</td>
<td>cooling down to inoculation temperature</td>
</tr>
<tr>
<td>5. INOCULATION</td>
<td>sterilised and ready</td>
</tr>
</tbody>
</table>

Table 3.7

The options available from the **Fermenter** menu when **Sterilization** is selected are **Start**, **Edit** and **Quit** (only available if a sterilization has already been started). **Start** and **Edit** lead to the **Sterilization options** dialogue box shown in Figure 3.18. (Section 3.2.6). **Steril/Close** leads the same dialogue box and offers a "one-step" option to decontaminate the fermenter by sterilization at the end of a fermentation and close it down on completion.

### 3.9.9 Altering Fermenter Settings On-Line

All the fermenter settings can be altered online by selecting the **Fermenter settings** option of the **Fermenter** menu to open the **Fermenter properties** dialogue box described in section 3.1.9. Some options such as the Device model and Port settings should not be changed under any circumstances while a fermentation is in progress or data and control information will be lost.

### 3.9.10 Altering Parameter Settings

The normal Parameter menus available for Adding to and the Editing the main “pool” of process parameters stored for selection whenever a fermenter is started. These parameter definitions are not altered by changes made when they have been selected and assigned to an active fermenter (although any changes are stored with the archived fermenter file and are available if it is subsequently used as a recipe on starting another fermenter).

Bearing this in mind, there must be a way to edit parameter definitions on line. IRIS also adds the possibility of adding additional parameters at any time during the fermentation. This is achieved by opening the **Fermenter** menu and selecting **Parameter settings**. The **Fermenter parameters** dialogue box appears.
Parameters from the main "pool" (shown in the left-hand list) can be added to those displayed for the current fermentation (right-hand list) by clicking on them to highlight and then using the >> button. This is a one-way process and chosen parameters cannot be removed.

Parameters on the right-hand side can be edited by clicking on the parameter to highlight in blue and then clicking on the Edit button.

This leads to the full Edit measured parameter dialogue box (or analysis parameter etc. as appropriate) as shown in figure 3.12. Editing of the parameter definition proceeds using the information given in Section 3.17. New values are entered in the appropriate text edit boxes and On/Off changes made via tick boxes.

When all the changes are made, click on OK to exit the dialogue box.

### 3.9.11 Statistics (communications information)

Statistics options only become available when a fermenter is active and are found in the Extras menu. Fermenter is the only choice on the sub-menu available unless you have the special options of a balance system or gas analyser.

The Fermenter Statistics dialogue box provides constantly updated information on the status of communications between the computer and the fermenter.

**Request send** is the number of times the computer has tried to contact the fermenter.

**Request received** is the number of times the fermenter has tried to contact the computer.

**Time outs** records how often the computer has waited for acknowledgement and has not been given it during a fixed time period.

**Last type send** is what sort of information the computer has requested of the fermenter.

**Last type received** is the sort of information the fermenter has provided to the computer.

**Last status** is an indication of the up to date condition of the communications situation.

**Count with last status** is an indication of how many messages of this type have been received.
The meaning of the numbers is not so important here, it is whether there are any error messages or large
time outs indicating a failure in communications. If you are receiving no data from the
fermenter, this screen is a good place to look for confirmation of a problem and, later, the confirmation of
a solution.

Simple trouble-shooting measures for communications problems are:

1) Is the cable connected at each end?
2) Is the cable connected to the right COM port on the computer?
3) Is the cable connected to the right fermenter?
4) Is the cable earthed at one end?
5) Is the fermenter instrumentation switch ON and set for REMOTE operation?
6) Is the Port setting correct? eg. a fermenter is on COM 2 and it set up for COM 1.
7) Is the device model correct? eg. An ISF unit is set up as SDDC.
8) Are the baud rate settings etc correct? eg. 9600, 8,N,2. is usual.
9) Is there any conflict between the com port and other devices? eg. your mouse is on the same
   COM port as the fermenter as far as Windows is concerned.

When everything is working correctly the messages and status counts will change every few seconds with
relatively few time outs.

3.9.12 Alarm Handling

Alarm messages are displayed in a separate window which, by default, is active as soon as IRIS is
started. Of course, no data is present until a fermenter is started. Every fermentation file carries alarm
information and this can be printed in reports from the history viewer. For the duration of the fermentation,
alarms are listed and coloured according to the alarm condition (yellow for alarm, or red for critical) for
each parameter. Other alarm conditions are also listed eg. communications problems.

The alarms screen is shown in Figure 3.43.

The columns of the Alarm display are mostly self-explanatory:

![Figure 3.48]
A... is an Ask field with a “spot” appropriate to the alarm colour.

**Num**: Each alarm is numbered

**Fermenter**: The Alarm window holds messages for every active fermenter.

**Parameter**: Each parameter in an alarm condition is listed separately.

**Value**: The actual value of the parameter in alarm condition is shown.

**Alarm type**: This can be Hi Alarm (yellow) Hi Critical (red), Lo Alarm (yellow), Lo Critical (red) or a non-parameter error eg. NO COMMS (red).

**Time/Date**: Real time marking of the alarm state.

**Running Time**: The relative time from the start of the fermentation when the alarm occurred.

Alarms can be acknowledged by right-clicking on an individual alarm message to highlight it in blue. A **Clear** button appears and clicking on this will acknowledge the alarm. This is shown by the message turning white.

A quicker way to do this is to left-click on the button next to the alarm message in the A... column. The spot turns green to show acknowledgement.

### 3.9.13 Entering Analysis Data On-line

This section is relevant only to active fermentations where analysis parameters are selected for the entry of off-line analysis data produced by assays on samples taken from the fermenter. Often, these assays take some time and the data is entered into the archived file after the fermentation has finished via the History Viewer (see Section 4.5).

However, it is not unusual for some analysis data to be available while the fermentation is in progress. In this case, the following steps will allow you to enter the data for display and graphing:

When an analysis parameter is right-clicked to activate the **Edit** button from any of the data views, the **Analysis parameter data** dialogue box appears. This is only available for Analysis parameters where data must be entered from the keyboard eg. Dry Weight.

This is a special case of a simple text entry dialogue box with an upper display area listing all the previously entered values for the chosen analysis parameter with time, date and status (valid or rejected).

Click on the **Add** button and use the text edit boxes to enter the time in days, hours and minutes when the sample was taken plus its value at that time. The new value(s) are automatically added to the list. An incorrect value can be discounted for the purposes of display and graphing by clicking on it to highlight it and then clicking **Reject**.

The final option is setting the **Time from** either the start of the fermentation or from the inoculation time. Click on **Close** to leave the dialogue box.
3.9.14 Closing a Fermentation
This is no different to closing any other Windows file. Click on \[ \times \] in the top right corner of the active fermenter window or use the Close option of the menu activated by clicking on the HAT file symbol. A message box confirming the closedown of the fermenter appears.

If no fermenter is active the Exit option of the File menu can be used. Using this option without closing an active fermenter first results in a message asking for closedown before you will allowed to exit the IRIS main program.
4 HISTORY VIEWER & CORRELATION TOOL

4.1 Introduction
The History Viewer is a separate part of the IRIS program which deals with all things relating to data which has been already stored to disk. Specifically:

a) Display and annotation of a single historical data file.
b) Comparison of more than one historical file
c) Generation of reports based on historical data
d) Entry and modification of off-line analysis data
e) Export of historical data for use by other applications
f) Printing of historical data

A separate Correlation tool which uses historical data will also be mentioned in this chapter.

Historical data can refer to information stored to disk for a fermentation still in progress. In this case, the file is read-only and no automatic updating of the parameter data takes place during the time you work with this copy of the file (of course, the data continues to be logged in the original version).

The IRIS PRO version of the History Viewer can be used as a stand-alone program by individuals on a networked site and will load historical data files via FTP (File Transfer Protocol). Report data can be e-mailed to remote locations if desired.

A shortcut can be created on the desktop to the History Viewer or the program called from the File menu of the main IRIS program.
4.2 Menus & Toolbar Buttons

4.2.1 Before a File is Opened

A simplified range of options for both menus and toolbar is available before a historical data file is opened:

The Open command leads to a file selection window which works in the standard Windows way.

Open via FTP leads to a dialogue box requiring entry of a user name and a location from which to get the file.

Import IRIS file is an option only for those with files stored by the DOS version of IRIS who wish to convert the information to the new *.iri file format.

Both the Log and the Header file must be in the Infors AG folder together for the conversion to be effective.

Print Setup leads to the standard Windows dialogue box for altering printer settings.

1...4 lists the most recently used files for quick re-loading.

Exit closes the History Viewer application.

The View Menu option allows for control over showing the Toolbar and the Status Bar only at this stage.

The Help menu leads to the standard Windows help screen layout with information specific to the Viewer.
The only toolbar options available at this stage are:

- **Open** a file
- **Save** a file
- **Help**
- **Context Help**

### 4.2.2 When a File is Open

When a file is selected (see next section) the following options become available:

- **Open**... leads to the file selection box
- **Open for compare** allows subsequent files to be opened for comparison on a common graphical display.
- **Open via FTP**... allows remote access to a file.
- **Close** terminates the use of individual files.
- **Save** writes any changes back to the *.iri disk file.
- **Save as...** allows the file name to be changed.
- **Export**... allows a graph to be saved as either an enhanced metafile (*.emf) or a bitmap (*.bmp).
- **Import IRIS file** allows files created under the DOS version to be graphed and manipulated.
- **Print Setup**... opens the standard Windows dialogue for changing printer settings
- **Print**... opens the standard Windows dialogue for printing.
- **Generate report** leads to a Report Wizard for text-based output of data.

1..4 Shows the most recently used file names.

**Exit** closes the History Viewer along with any open files.

The **Edit** menu is greyed out at this stage as it functions with text-based reports to offer the standard Windows functions of **Undo, Cut, Copy & Paste**.
Toolbar toggles the presence buttons at the top of the screen.

Status Bar toggles the presence of the bottom information line

Zoom In increases the “magnification” of the view of a graph

Zoom Out decreases the “magnification” of the view of a graph

Zoom to Fit ensures all the data fits in the width of the viewing window.

Follow is used to set how much data is shown on a single display window.

Properties leads to a dialogue box where many different options relating to the graphical display can be set: Colours for background, grid and axes, the font used, single or multiple x axis etc.

The Windows menu lists the standard ways to display open windows i.e. Cascade, Tile and Split plus shows the filenames of open windows.

Help leads to IRIS-specific information in a standard Windows format.

The button bar now has a number of extra functions available, depending on which parts of the History Viewer application are being used.

- **Open** a file
- **Save** a file
- **Zoom IN**
- **Zoom OUT**
- **Zoom to Fit**
- **Time Line**
- **Label Marker**
- **Time Marker**
- **Value Marker** (only available when a parameter has been selected in the “bars” section)
- **Print**
- **Help**
- **Context Help**
4.3 Opening a File

Select the File menu after opening the History Viewer and choose Open...

A file can now be selected either from the default folder or by navigation through the hard disk to a chosen alternative.

All the *.iri files are associated with the HT icon.

All buttons and options are standard Windows.

Single click to select the desired file then click on the open button.

The data is immediately loaded and the graph displayed.

Opening a file via FPT involves a dialogue box requesting a user name and password plus the address of the remote server with

the required file.

Importing a IRIS file needs the *.log and *.hea files to be in the same folder. Selection and opening of the Graphical Viewing display then follows the same pattern as a standard IRIS NT file.
The Graphical Display which opens initially looks something like this:

![Graphical Display](image)

The top portion of the display is the graph (showing just a single 0-100% X axis unless altered) with the time base on the Y axis determined by the total time of the fermentation. This is the zoom to fit view. Scroll bars allow movement of the graph if a "magnified" view is selected using the zoom IN option.

Right-clicking anywhere on the graphical display brings up the same properties dialogue box as selecting the **View** menu then the **Properties** option.

The options shown are mostly self-explanatory.

The time axis mode has two radio buttons which toggle between a display in "real-time" hours/mins or a time base beginning at the point of inoculation.

From this dialogue box the appearance of the graphical display can be adjusted to your requirements.

The bottom portion of the display is a series of "bars" showing the set point and alarm limits for each parameter. The size of this section is...
adjusted by “pulling” the dividing bar between the two parts of the display up or down. The colours of each parameter on the graph are shown and a tick box is provided at the left of the display to select/deselect the parameters to be shown on the graph.

Clicking on the main parameter bar display causes that parameter to be selected and highlighted in blue. This is vital for use of the Values Marker option for annotating the graph. A double click will open a dialogue box for editing and displaying various features of the display of the chosen parameter:

![Parameter options dialog box](Figure 4.8)

- The presence of a line and its colour, type and use of a marker are all dealt with on the graphics option section.
- The statistics fields are for information and cannot be edited.
- The axis value can be adjusted and a special button is available for analysis values to enable the post-fermentation editing of data entered off-line.
- The Line style and Marker style allow a plot for an individual parameter line to be given unique display which will be clear if a monochrome print-out is made or the number and closeness of lines make them difficult to distinguish.
- Lines can be combinations of dots and dashes. Markers are triangles and boxes.

### 4.4 Comparison

The simplest form of comparison is to open two files separately and adjust the size of their respective display windows until they are equivalent and tiled one above the other.

The History Viewer also allows for a more “interactive” comparison of the data from several fermentations by using the Open for Compare option on the File menu. This opens a standard file selection window and choosing a file leads on to a new dialogue box asking for selecting of those parameters from the new fermentation which you wish to compare with the existing graph. Selection is made by single clicking on the parameter name to highlight it. Statistical data about the parameter is also displayed to help ensure you make an informed selection.

By default, new parameters have part of the file name added to them to differentiate them from those already displayed. New parameters are added beneath the current ones and are initially not selected for display. Use the mouse to click in the empty tick boxes on the left of each parameter to add them to the display.

The file name is also been altered to show the file is now a comparison and to allow its saving as a separate entity to the two (or more) files which created it. The use of a time-base starting at inoculation is clearly an advantage if the files making up the comparison plot were started at different times of day.
4.5 Annotating Graphs

4.5.1 Time Line

Although it is not strictly an annotation to the graph, the Time Line is an invaluable way to look at the actual values of all the displayed parameters at a given time and to "scan" the time base looking for points of interest.

The Time Line can be activated by clicking on the appropriate button on the tool bar. It is described as Check on Position in the help balloon which appears if the cursor is left over the button for a few seconds).

A red line appears in the graphical display area and the cursor changes to point downwards. The altered cursor is used to "pick up" the time line and move it horizontally along the displayed area of the graph. As the Time Line passes over each parameter plot, the bar graph beneath changes as the current value of each parameter is displayed for the point where is currently positioned. The actual bar graph display also changes to give a quick visual confirmation of the trend eg. a rise or fall in the value and/or transition into an alarm limit area.

The Time Line will stop at the edge of the displayed area and the horizontal scroll bar must be used to display a new area of the graph.

The Time Line facility must be cancelled by clicking its button on the toolbar again for any other option to annotate the graph to become available.
4.5.2 Label Marker

This option allows a text message to be placed anywhere in the graphical display area which is not related to a specific time or parameter value. It can also be used as an illustration of the general features which are available for customising marker boxes. It is selected from the toolbar by clicking on the appropriate button. A special Cursor with a balloon “label” attached to it appears. Click on any part of the graphical display area to make a box appear carrying a default message saying “Text”.

The characteristics of this box and its message can be edited and changed very easily.

Right Click on the text box to activate the following dialogue box:

![Dialogue Box](image)

This box is essentially the same for all the Markers with only the data held in the edit box at the top varying.

The **Font**, **Line** colour and **Background** (fill) colour of the marker box can be changed along with the **Rectangle style** and characteristics of the line linking the box to the part of the graph to which it points.

An **Insert** button activates a combi box with several default options to add to the text e.g. the name of the fermenter.

The marker box can be picked up with the cursor and moved around the graphical display and the line from the box can also be picked up and dragged to wherever it is needed (see illustration).

Any marker can be removed from the graph by right-clicking on the box then choosing **Remove**.

4.5.3 Time Marker

This marker is selected and manipulated in exactly the same way as the text box. The difference is that the time is placed in the box as a default.
4.5.4 Value Marker

This has the most options and special features. Firstly, selection is the same as the other markers but an individual parameter MUST first be highlighted in the bar display area by clicking on it. Also, the line coming from the dialogue box only follows the selected parameters plotted line on the graphical display. The colour of the marker box is, by default, the colour chosen for the selected parameters plotted line.

The Insert button now includes a number of options which can be added to the displayed marker box including the name, units and line type for the chosen parameter.

Markers of different types can be mixed on the one graph and several of each type can be shown. Examples are shown in the illustration below.

4.6 Entering Analysis Data

The dialogue box shown when a parameter is selected from the bar display and double-clicked (Figure 4.8) has a special button for entering analysis data. Logically, this button is only available for Analysis parameters where data must be entered from the keyboard e.g. Dry Weight or cell counts.

Clicking on this button shows the data entry window opposite which can be treated as a special sort of text editor.

Click on the Add button and use the edit boxes to enter the time in days, hours and minutes when the sample was taken plus its value at that time.

The new value(s) are automatically added to the list. An incorrect value can be discounted for the purposes of graphing by clicking on it to highlight it and then clicking Reject.
4.7 Generating Reports

Data can be output and exported in text form from the History Viewer by using the Generate report option found in the File menu. This leads to a series of dialogue boxes grouped together as the Report Wizard. The first choice is which parameters will be included in the report:

Desired parameters are selected by clicking on them in the Available parameters then using the “>>” button to transfer them to the Reported parameters list.

Unwanted selections can easily be returned using the “<<” button. Clearly the “All” alternative buttons make these changed for the whole list of parameters.

Back, Next, Cancel and Help buttons are all standard Windows components of this sort of dialogue box.

The next part of the process is a dialogue box with radio buttons which allows for selection of the time base (as real time from the start of the fermentation eg. 13:05 or from inoculation as time 00:00).

Progress by clicking Next.

A second section uses radio buttons to select if a Standard report header will be used or a Batch ticket. If this alternative is chosen, a text entry box for a filename and a browse button for file selection become active. The usual navigation buttons for the dialogue box appear at the bottom of the window. Progress by clicking Next.

Radio buttons in the last windows allows for ALARM reports to be printed after the parameter data and for data to be averaged if required. Selecting this option activates a second area named Averaging options. Here the average time and average interval in minutes can be entered into text boxes and radio buttons control the choice between as simple average and one using the square roots method. To progress, click on Finish.

If you have kept to the default options of standard header, no alarms and no averaging, a window containing the report is generated which will looks like figure 4.14.

The file header gives information about the fermentation followed by a listing of the parameter values for each logged time interval. Measured, analysis and calculated parameters can all be listed if they have been selected.

This data can be printed, saved and copy or cut for inclusion in another application eg a spreadsheet using the standard Windows menu options and tool bar buttons for these tasks.

The Generate report option on the menu bar leads you back to the beginning of the Report Wizard. Combination data from several fermentations in a comparison file can also be reported from the relevant graphical display.
4.8 The Correlation Tool

This feature is only available on versions of IRIS NT PRO and above. It allows two lots of parameter data from within or between fermentations to be plotted one against the other to determine the degree of "relatedness" between them using a statistical method which produces a Correlation co-efficient. This can take a value from +1 (strong positive correlation) to -1 (strong negative correlation). Mid values mean that a real association (one way or the other) is not absolute.

This tool can be called from the IRIS main program File menu or can have its own shortcut on the desktop. Calling the program results in the following dialogue box, Correlation parameters, as shown in Figure 4.15.

A “...” button is used on the left-hand side to select which file will provide the parameter data for the vertical axis. Clicking this button leads to a standard Windows Open file selection window where the desired file can be selected (see Figure 4.5). On selection, the parameters from that fermentation are listed on BOTH the Left hand (Vertical) and Right Hand (horizontal) areas of the screen. This allows rapid progression when both parameters will come from the same file.

If a different file is to provide the Y axis data then the right hand “...” button must be clicked and the selection process repeated.

Individual parameters on each “side” are selected by clicking on them and finally clicking the “OK” button at the bottom of the screen. The graphical display window is then shown with plot of the data and the correlation co-efficient displayed - see Figure 4.16.
The graphical display menu and toolbar buttons over most of the facilities of the main History Viewer and work in a similar way. The correlation value is contained by a marker box (although this is not apparent with the standard defaults set). Right-clicking on the value allows the characteristics of the box to be altered just like a standard value marker box (see Section 4.4.4. and Figure 4.10).

The completed graph can be sent to remote locations by email using the Send option in the File menu.
The Text button looks a little different to its counterpart in the History Viewer but works in the same way.

A “Regenerate” button appears on the toolbar and this returns you to the start of the parameter selection process (Figure 4.15). The Properties option in the File menu provides the same facility.

Options for the main graph are set from a “floating menu” which is activated by right-clicking on a blank area of the graph. Selected options are marked with a tick. Dialogue boxes option for modification of features such as Grid settings.

4.9 Printing

The options for Print Setup and Print are standard implementations of Windows dialogue boxes. The Print Preview option leads to a new window with a new set of toolbar buttons and options which allow great flexibility in how a graph will be printed onto paper.

This first set of options allow for direct printing and navigation in multiple page documents Next Page & Previous Page. Two Pages can be shown on the one screen and the Zoom IN and Zoom OUT buttons allow close-up or full page views. A header can be added to the pages and this involves a special dialogue box activated by clicking the Headers button. Close allows a return to the main graphical display without printing.
The second of the toolbar deals with the appearance of the printed page. Tickboxes allow the choice of displaying borders around the page preview and the showing of the “x” axes of the graphs. 1..4 is a choice of how many graphs will be fitted on one page.

If you create a History graph with a timebase which has not been “zoomed to fit”, the graph will be spread over several pages if option 1 is chosen or printed with multiple graphs on the same page is options 2, 3, or 4 are selected instead.

**Printer Setup** leads to a standard dialogue box for determining the orientation of the print (landscape or portrait - the default) and the type of paper feed. **Page setup** also provides these options and includes the settings of page margins.

The print options for the Correlation Tool are very similar except no provision is made for more than one graph per page.
5 CONTROL OPTIONS

5.1 Manual Control

Use the QUICK EDIT functions by right-clicking on the chosen parameter in any of the views of live data (Text, Graph, Schematic or Bar). The dialogue box revealed allows changing of set point using a “slider control” or by directly editing the set-point value in the relevant text box.

N.B. The Light version of IRIS NT does NOT have any remote control functions but the DDC instrumentation of the Labfors and Sixfors allows for time-based profiling (see fermenter manual).

5.2 Control Language Introduction

Control language allows the computer to make decisions about control strategies based on current conditions and allows the fermenter control to be sequenced to follow the needs of an organism's life cycles. You can alter various parameter details such as log rates, setpoints, alarm limits, backup values etc. Values may be derived in real time for use in control determination.

For example a fermentation may have a lag phase, growth phase and a death phase. In each of these phases the conditions can be altered automatically not only to detect a phase change but to force a phase change. Consider an organism which has a 4 hour lag phase followed by an exponential growth phase. It is possible within the control language to decide that if the lag phase lasts more than 5 hours to alter the conditions such that growth is encouraged. If after a further 2 hours nothing has happened you may wish to close down the fermentation.

The control language is written in a set of sequences, each sequence consists of a page of commands. It is important to realise that ALL commands in a sequence are executed together, there is no loop operation as in imperative languages. We need only have decisions based upon control strategies. We may change sequences, in any order based upon decision statements. Therefore, we can visualise the control system as a set of note pages. Each page contains a set of ideas about the fermentation. As the fermentation changes so the note page changes. In essence, calling these pages “Sequences” is a misnomer as they do not have to be executed sequentially. Sequences can be prepared for events which may or may not happen - the progress of the fermentation decides which sequences will be active!

In IRIS NT, up to 30 sequences may be defined per fermenter with an unlimited number of command lines per sequence.
5.3 Opening Control Language Sequences.

A compiler is built into the IRIS NT software which takes Sequence commands written in a variant of the Notepad text editor as ASCII characters and converts them to a “pseudo machine code” for fast and compact execution. Sequences are saved with a .SEQ file extension and, by default, are saved along with the IRIS data in the Infors AG folder.

Control sequences usually appear as part of the fermenter start-up initiated from the FILE menu. An option is provided to load a control sequence and a Browse button used to look for appropriate sequence files. By selecting this option we are presented with file display window listing a number of sequence files.

Sequences are called up and edited from the EDIT menu of an on-line fermentation. The options that we are now concerned with are the Edit Current, Create New, and Load File choices in the Control Sequence sub-menu. Selecting one opens a window on a text screen with sequences displayed in a sequential fashion, separated by the # character and an associated number. Optional the sequence number can be followed by a seq name and a evaluation time in s: #2, MY_TEST, 2

This is seq=2 (the third sequence) with the name MY_TEST and it will be calculated every 2 seconds. If the seq evaluation time is given as a option IRIS uses 10s per default.

5.4 Writing a Control Sequence

Start a sequence by typing # and a number (0 for the first, 1 for the second etc). Press ENTER. The cursor is now placed on the next line at the beginning of the line. Now we are able to enter the commands. There can be any number of commands on a line, up to the limit of the line’s input length, but each command must be separated by a semi-colon ‘;’. You may simply type each command on a newline, in which case the separator is not required.

i.e.       ph.sp=6.85 ; ph.ua=7.12
or            ph.sp=6.85
              ph.ua=7.12

To move to a new line you may type ENTER.

If you make an error within the program a message will be issued and you must make the appropriate changes to the program and recompile. A syntax checker will not allow a sequence to be compiled with an incorrect “grammar”.

When you have finished editing the sequences which you close the window using the right-most menu icon and selecting close or with the “x” button. An “Apply Sequence” dialogue box appears and you can select which sequence in a list is to made active and then confirm the revised sequence is to be used right away.

Menu options allow for loading a new sequence, compiling the present one without making it active and to make the revised sequence active by calling the “Apply Sequence” dialogue box while the compiler window is still open.

Standard File menu options allow saving, save as and printing of the sequence.

You do not have to finish entering all the sequence information now as you can freely edit the sequence programs while the fermentation is running. If you edit the sequence while the fermentation is active then only when you have successfully compiled the sequence will it be swopped for the original.
5.4.1. Control Sequence Wizard

The details of the control sequence language are described later in the manual. The purpose of the wizard is to simplify sequence programming largely to "filling in the boxes".

The first screen shot shows an important change with regard to clarity of a sequence – the use of different colours for different parts of the sequence.

Parts of the parameter definition such a V (value) and sp (setpoint) are highlighted by colour. The IF {} ELSE structure is also highlighted in colour. //Remarks are highlighted in green in this case.

The colour options are selected from the Edit..Properties menu of the compiler.
Starting to write a sequence in automatically invokes the **Component** dialogue box.

To start the wizard and access the whole range of possibilities for a control sequence, right click on an empty part of the compiler screen and the Wizard dialogue box appears:

Select **Build expression**: 

![Figure 5.3](image1)

![Figure 5.4](image2)

![Figure 5.5](image3)
The buttons below the line where the sequence is building allow simple operations such as addition or multiplication to be accessed by a single click.

Selecting eg. parameter in the bottom left pane leads to all parameters for the current fermentation to be shown and selecting one of these leads to all the extension such as sp (set point) to be shown. Select one of these and click on the paste button for this part of the sequence to be added to the topmost dialogue.

Clicking on eg. the IF option, leads to a new set of dialogue boxes and options, all of which work in essentially the same way:

Below, is the structure of an IF {} (then) ELSE decision structure is shown with drop down lists of what conditions and arguments can be used.

![Figure 5.6](image1)

![Figure 5.7](image2)
The conditions which can be applied are displayed in a drop down list first, so the IF section can be filled in.

The true and false options are shown in a similar way for "then" and "else".

The dialogues for eg. Ramp and Assert will differ but the method of filling in the blank(s) and picking options from a drop down list remain the same.

To make the best of the wizards, it is still essential that you familiarize yourself with the options and capabilities of the control sequence language from the section in the main manual and try replicating some of the examples given using the wizards available.

Behind these dialogue boxes, the control sequence is built up in the normal way. It is possible for experienced users to ignore these dialogue boxes and write sequences without help, if desired.

5.5 Load Control Option.
Here you can load a previously defined sequence set into the current fermentation. It is important that you ensure that all the variables used in the loaded sequence are used (with the same names) in the current fermentation. Although it is loaded on entering the command it is not compiled until you edit the sequence. See the section above for further details.

5.6 Control language Structure
The grammar of the language is quite strict and has an operator priority similar to C or Pascal. The priority is as listed below. When expressions within sequences are evaluated, it is in this order!

<table>
<thead>
<tr>
<th>Priority</th>
<th>Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>high</td>
<td>(Bracketed operations)</td>
</tr>
<tr>
<td></td>
<td>Internal functions (RAMP etc)</td>
</tr>
<tr>
<td></td>
<td>Math functions</td>
</tr>
<tr>
<td></td>
<td>^ (exponential)</td>
</tr>
<tr>
<td></td>
<td>*, /, *=, /=</td>
</tr>
<tr>
<td></td>
<td>+, -, +=, -=</td>
</tr>
<tr>
<td></td>
<td>AND, OR, NOT</td>
</tr>
<tr>
<td>low</td>
<td></td>
</tr>
</tbody>
</table>
5.7 Command Structures.

Listed below are all the commands available in the control language together with a representation of the grammatical structure. This is intended for use as a complete reference system. The codes have the following meanings.

- `<var>` :: the variable name i.e. pH
- `<part>` :: part of a variable i.e. ph.sp
- `<real>` :: a real number of the form 1.23 or 12.3E3 e.g. has decimal values
- `<int>` :: an integer number 10 etc. e.g. whole numbers
- `<const>` :: a constant number defined in the language.
- `<val>` :: can be a `<const>` OR `<real>` OR `<int>` OR `<part>`
- `<seq>` :: sequence to execute.
- `<local>` :: locally defined variable eg. used by a particular sequence only
- `<bool>` :: a truth value expression eg. Greater than, less than
- `<dest>` :: `<var>` OR `<seq>`
- `<op>` :: mathematical operator eg. * OR / OR + OR - ^
- `<term>` :: `<term><op><val>`
- `<exp>` :: `<term><op><exp>|(<exp>)`
- `<time>` :: a value representing time in seconds

5.8 Mathematical Operators

- `<val>` * `<val>` 23.0 * pH.sp
- `<val>` / `<val>` pH.v / oxygen.sp
- `<val>` + `<val>` temp.bv + 0.2
- `<val>` - `<val>` ph.sp - 2.0
- `<val>` ^ `<val>` oxygen.v ^ 2
- `<dest>` *= `<val>` pH.sp *=1.01 i.e. ph.sp = ph.sp * 1.01
- `<dest>` /= `<val>` pH.sp /= 1.01 i.e. ph.sp = ph.sp / 1.01
- `<dest>` += `<val>` oxygen.bv += 2.5 i.e. oxygen.bv = oxygen.bv + 2.5
- `<dest>` -= `<val>` rq.v -= 2.3 i.e. rq.v = rq.v – 2.3

5.9 Relational Operators

- `<val>` < `<val>` ph.sp < 7.8
- `<val>` > `<val>` ph.sp > ph.v
- `<val>` <= `<val>` oxygen.lr <= 160
- `<val>` >= `<val>` oxygen.v >= oxygen.lc
- `<val>` == `<val>` time(2:0) == elapsed

5.10 Assignment

- `<dest>` = `<val>` ph.sp = 7.2

5.11 Functions

All functions return a value of type `<val>`

- `TIME(<val>):(<val>)` time(3:20)
- `LOG(<val>)` log(oxygen.v * stirrer.val)
- `LN(<val>)` ln(oxygen.v)`
**5.12 System Variables**

**SEQ**
accepts values of type `<val>`
if(ph.v > 7.5){SEQ=1}else{SEQ=2}

**ELAPSED**
the elapsed time for the fermentation in seconds. Note This time stays zero until the file is inoculated
if(time(0:39)<elapsed){SEQ=1}else{SEQ=2}

**SEQ_TIME**
the time spent within the current sequence. Each change or seq leads to reset of this time. Note this time can run before inoculation
if(seq_time > time(1:0)){seq=2}

**NORMAL**
the value associated with a status value if objects status is not in an alarm.
if(ph.st == NORMAL){.....}

**HI_CRITICAL**
the value associated with a status value if the objects status is in a high critical condition.
if(ph.st == HI_CRITICAL){.....}

**HI_ALARM**
as above, but related to the high alarm condition.

**LO_ALARM**
as above, but related to the low alarm condition.

**LO_CRITICAL**
as above, but related to the low critical condition.

**ON**
defines an ON or TRUE condition.
if(ph.lia == ON){.....}

**OFF**
defines an OFF or FALSE condition.
if(ph.lia == ON){.....}
5.13 Description of Commands

Listed on the following pages are full descriptions of all the major operators and functions. The descriptions are given together with examples. We hope to maintain a user network of useful control function statements and sequences. This may be used to gradually build a reference library of control structures for use in future fermentations.

5.13.1 The RAMPC function

Name: RAMPC

Type: Function

Parameters: 4

- 1. <var> Variable name.
- 2. <val> Value to attain.
- 3. <bool> Condition on which ramp is active.
- 4. <val> incremental value of ramp.

Returns: <val> The current value of <var>.sp

Structure: RAMPC(
variable name,
destination value,
condition in which ramp occurs,
slope of ramp
)

NOTES: None

Description:
This increases (or decreases) the current value of the variable setpoint by an amount given as the ramp slope. The duration of the ramp will depend on the starting value, the destination value and the ramp slope. The ramp function is only active while the ramp conditional is TRUE. That is, if the conditional becomes FALSE during the ramp operation it will stop ramping. It will only commence ramping if and when the conditional again becomes TRUE.

Example:
To ramp the pH setpoint value from its current setpoint value (of say 7.2) to 6.5 in 0.1 increments, at an oxygen value of less than 75 we would write...

rampc (pH,6.5,(oxygen.v < 75.0),NEG(0.1))

pH: identifies the variable who's setpoint is to be ramped.
6.5: gives the destination value (the value to be achieved upon completion of the ramp)
(oxygen.v < 75.0): sets condition for ramping (while O2 less than 70%).
NEG(0.1): specifies the increment per evaluation to be -0.1.
5.13.2 The RAMP function

Name: RAMP

Type: Function

Parameters: 4 types
- 1. <var> Variable name.
- 2. <val> Value to attain.
- 3. <time> Time at which ramping starts.
- 4. <time> Duration of ramp.

Returns: <val> The current value of <var>.sp

Structure:
RAMP(
  variable name,
  destination value,
  start time of ramp function,
  duration of ramp
)

NOTES: None

Description:
This increases (or decreases) the current value of the variable setpoint by an amount given as the destination value. The ramp slope can be determined form the destination value, the current value and the duration of the ramp.

Example:
To ramp the pH setpoint value from its current setpoint value (of say 7.2) to 6.5 in 0.1 increments, at an oxygen value of less than 75 we would write...

ramp(pH,6.5,time(13:0),time(0:10))

pH: identifies the variable who's setpoint is to be ramped.
6.5: gives the destination value (the value to be achieved upon completion of the ramp).
time(13:0): sets the time at which the ramp will start. In this case its at 13 hours 0 minutes into the fermentation.
time(0:10): specifies the duration of the ramp. In this case the ramp will last 0 hours 10 minutes.

Note that the time() function returns a value in seconds and we could write the following equivalent statement.

ramp(pH,6.5,time(13:0),600)
5.13.3 The LIMITS function

Name: LIMITS
Type: Function
Parameters: 6
  - 1. <val> Lower critical value.
  - 2. <val> Lower alarm value.
  - 3. <val> Setpoint value.
  - 4. <val> Upper alarm value.
  - 5. <val> Upper critical value.
  - 6. <var> Variable identifier.

Returns: <val> The current value of <var>.sp

Structure:
 LIMITS(
    lower critical,
    lower alarm,
    setpoint,
    upper alarm,
    upper critical,
    variable name,
  )

NOTES: None

Description:
This sets all the parameter limits at one time. The values of the parameters may be conditionally derived or calculated values.

Example:

limits(4.5,4.8,5.0,5.2,5.5,ph)

sets the ph limits to :-
  ph.lc <- 4.5
  ph.la <- 4.8
  ph.sp <- 5.0
  ph.ua <- 5.2
  ph.uc <- 5.5
5.13.4 The ADJUST function

Name: ADJUST

Type: Function

Parameters: 3
- 1. <var> Variable name.
- 2. <val> Value of setpoint.
- 3. <val> Value used to adjust setpoint.

Returns: <val> The current value of <var>.sp

Structure: ADJUST(
  variable name,
  value of setpoint,
  adjustment for setpoint
)

NOTES: None

Description:
This alters a parameters setpoint by adding the setpoint value to the adjustment value (provided the alteration does do push the setpoint into an alarm region). So for example with the following equation ....

ADJUST(pH,7.0,0.5)

The setpoint of pH is set to 7.5. This trivial example does not show the full power of the statement, consider a circumstance in which we wished to adjust the stirrer setpoint by a value dependant on the error in oxygen value from a predetermined optimum value. We could have stirrer setpoint adjusted to give an optimum oxygenation as follows.....

ADJUST(stirrer,300,pid(oxygen,0.5,0.2,0.1))

Here we are using the PID() function to give us the adjustment to the stirrer setpoint due to an error in the oxygen value.
5.13.5 The LIM function

Name: LIM
Type: Function
Parameters: 3
types
- 1. <val> Value to be checked.
- 2. <val> Minimum value of type (1).
- 3. <val> Maximum value of type (1).

Returns: <val> The current value of <var>.sp

Structure:
LIM( value to be checked,
     minimum value,
     maximum value
   )

NOTES: None

Description:
This used to check that a value is between two limits. If the value is outside the limits set then it is adjusted to the maximum or minimum allowed.

LIM(ph.sp,7.2,7.8)

The setpoint of pH is compared to the two limits 7.8(maximum) and 7.2(minimum). If it's above 7.8 the function returns 7.8, and if its below 7.2 it returns 7.2.

This is designed for checking the limits on response actions. For example, if a dosing pump is to operate between two limits but the value is set according to RQ we could write....

dose.sp=LIM(dose.sp,10,100)

This is equivalent to ...
if(dose.sp>100){dose.sp=100}
if(dose.sp<10){dose.sp=10}

5.13.6 List of IRIS Control Statement Operators

<table>
<thead>
<tr>
<th>NAME</th>
<th>DESCRIPTION</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMPLE MATHEMATICAL OPERATORS (FUNCTIONS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*</td>
<td>multiply</td>
<td>ph.v*3.2</td>
</tr>
<tr>
<td>/</td>
<td>divide</td>
<td>oxygen.v/2.5</td>
</tr>
<tr>
<td>-</td>
<td>subtract</td>
<td>ph.sp-7.0</td>
</tr>
<tr>
<td>+</td>
<td>add</td>
<td>ph.sp+3.2</td>
</tr>
<tr>
<td>+=</td>
<td>add and assign</td>
<td>ph.sp+=3.2</td>
</tr>
<tr>
<td>-=</td>
<td>subtract and assign</td>
<td>ph.bv-=1.0</td>
</tr>
<tr>
<td>/=</td>
<td>divide and assign</td>
<td>oxygen.sp/=0.98</td>
</tr>
<tr>
<td>*=</td>
<td>multiply and assign</td>
<td>stirrer.sp*=1.01</td>
</tr>
</tbody>
</table>
RELATIONAL OPERATORS (FUNCTIONS)

==  is equal?  if(ph.v==4.0)...

>=  is greater than or equal?  if(ph.v>=4.0)...

<=  is less than or equal? if(ph.v<=4.0)...

>   is greater than?   if(ph.v>4.0)...

<   is less than?  if(ph.v<4.0)...

NOT  inverter   if(NOT(ph.v<5)) ...

AND  Logical and conjunctive if(ph.v<5 AND ph.v>3)...

OR  logical or disjunctive   if(ph.v<5 OR ph.v>10)...

MATHEMATICAL FUNCTIONS

NEG  sign inverter  NEG(5) gives -5

EXP  exponent   EXP(5) gives e^5

^    Raise to power  10^5 gives 100000

LOG  take logarithm to base 10  log(10) gives 1

LN   take natural logarithm  ln(2.7182818) gives 1

SPECIAL FUNCTIONS

RAMP  Ramps a variable setpoint based on elapsed time.
      eg. ramp(ph,8.6,time(24:00),time(0:30))

RAMPC Ramps a variable setpoint based on absolute values.
       eg. rampc(ph,8.6,(pO2.v<80),0.01)

ADJUST Sets a variables setpoint to a value given but adjusts the value according to another offset

ASSERT Checks that a condition is assert(status!=HI_ALARM) is TRUE
       If the condition is FALSE then the fermentation is abandoned.

LIMITS Sets a variables limits limits(9,8.2,7,6.3,5,pH)

DEF  Defines a variable to be equal to a constant or an expression. There is a maximum of 5 DEF expressions per sequence. eg DEF evl=cur/oer

TIME Returns the time value in seconds. eg time(0:13)

5.13.7 PARAMETER COMPONENTS

<table>
<thead>
<tr>
<th>NAME</th>
<th>DESCRIPTION</th>
<th>VALUE ACCEPTED</th>
</tr>
</thead>
<tbody>
<tr>
<td>var</td>
<td>variable</td>
<td>NONE</td>
</tr>
<tr>
<td>var.sp</td>
<td>variable setpoint</td>
<td>real number value</td>
</tr>
<tr>
<td>var.uc</td>
<td>variable upper critical</td>
<td>real number value</td>
</tr>
<tr>
<td>var.ua</td>
<td>variable upper alarm</td>
<td>real number value</td>
</tr>
<tr>
<td>var.la</td>
<td>variable lower alarm</td>
<td>real number value</td>
</tr>
<tr>
<td>var.lc</td>
<td>variable lower critical</td>
<td>real number value</td>
</tr>
<tr>
<td>var.bv</td>
<td>variable backup value</td>
<td>real number value</td>
</tr>
<tr>
<td>var.v</td>
<td>variable value</td>
<td>real number value</td>
</tr>
</tbody>
</table>
5.13.8 FERMENTATION VARIABLES & CONSTANTS

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>var.st</td>
<td>variable status</td>
<td>real number value</td>
</tr>
<tr>
<td>var.lr</td>
<td>variable log rate</td>
<td>real number value</td>
</tr>
<tr>
<td>var.ld</td>
<td>variable log difference</td>
<td>real number value</td>
</tr>
<tr>
<td>var.ct</td>
<td>variable setpoint remote control</td>
<td>bool (On / Off)</td>
</tr>
<tr>
<td>var.ad</td>
<td>variable sensordata on / off</td>
<td>bool (On / Off)</td>
</tr>
</tbody>
</table>

**5.14 Command Language Examples**

**5.14.1 Linear increase of pH setpoint if oxygen concentration exceeds a certain value**

Define a change in pH if oxygen concentration exceeds 95%: This gives a linear response of pH to an excess of oxygen. At each calculation interval the pH is increased by 0.1.

\[
\text{if}(\text{pO2.v} \geq 95)\{\text{pH.sp} = \text{pH.sp} + 0.1\}
\]

**5.14.2 PH setpoint has switches according oxygen concentration**

Define a two level setting for pH depending on the dissolved oxygen concentration: Here only two values of pH are allowed as setpoints. The equation simply decides which one to use according to the condition specified.

\[
\text{if}(\text{pO2.v} < 70)\{\text{pH.sp} = 6.5\} \text{else} \{\text{pH.sp} = 7.5\}
\]
5.14.3 Exponential increase of flow setpoint

Define an exponential increase in flow rate depending upon the oxygen concentration: Here we use a simple relationship to obtain an exponential increase. Each time the equation is evaluated, the flow setpoint is multiplied by the difference between value and required. To prevent too dramatic a change we divide the difference by 10.

\[
\text{if}(pO2.v<75)\{(\text{Mass Flow.sp}^{*}=(75-pO2.v)/10)\}\text{else}\{4.0\}
\]

A slightly better equation which does not use a fixed value for the required value might be ....

\[
\text{if}(pO2.v<pO2.sp)\{(\text{Mass Flow.sp}^{*}=(pO2.sp-pO2.v)/10)\}
\]

In most cases the setpoint is the required value, so we obtain the most flexible equation by using it.

5.14.4 Bi-directional exponential flow control rate system

Define a bi-directional exponential flow control rate system: This is a more simple exponent equation but gives a direct control of flow. The idea in using such an equation (with exponentiation) is to eliminate the necessity of a dead band term because the response is more gradual.

\[
\text{if}(pO2.v<pO2.sp)\{(\text{Mass Flow.sp}^{*}=1.01)\}\text{else}\{(\text{Mass Flow.sp}^{*}=0.98)\}
\]

5.14.5 Calculate doubling time for biomass

Calculate doubling time for biomass: We use the formula.....,

\[
X_t = X_0 \cdot e^{ut}
\]

where

\[
X_0 = \text{Biomass at time 0 in gms/litre} \\
X_t = \text{Biomass at time t in gms/litre} \\
u = \text{Specific growth rate.} \\
t = \text{time.}
\]

As \(T_d\) (doubling time) = \(\ln(2)/u\), we have

\[
u = \frac{\ln(X_t) - \ln(X_0)}{T_t - T_0} = \frac{\ln(X_t/X_0)}{(T_t-T_0)}
\]

This equation is only valid during exponential growth period. The form for entering into IRIS is as follows....

\[
dt.v=0.69314718*\text{elap}/\ln(Bmass.v/Bmass0)
\]

where:

dt: is a calculated variable
elap: is the elapsed time
Bmass: is the Biomass analysis variable
Bmass0: is a constant for Biomass at time 0
### 5.14.6 Calculate the Biomass during exponential growth phase

Calculate the Biomass during exponential growth phase: This uses the formula given in (5).

\[
dt.v = 0.69314718 \times \text{elap}/\ln(Bmass.v/Bmass0)
\]

\[dt.v\] now becomes a constant \(dt\) ....

\[Bmass.v = Bmass0 \times \exp(dt/(0.69314718 \times \text{elapsed}))\]

### 5.14.7 Calculate the CO2 evolution rate

Calculate the CO2 evolution rate: This uses the results from a gas analysis system to determine O2 and N2 in the exhaust gas stream.

\[cpr = \frac{(F/(V*22.4))*(ECO2*(1-IO2-ICO2)/(1-EO2-ECO2)-ICO2)}{(Mass\ Flow/\ Vol) \times (0.2095-EO2/100)}\]

where ....

\[cpr\] : is carbon dioxide production rate
\[Mass\ Flow\] : is gas flow
\[Vol\] : is working volume
\[EO2\] : is exhaust O2 concentration

\[ca = cN2 \times CO2/(100-(cO2-EO2)-CO2) - CO2\]

### 5.14.8 Sample RQ calculation

Sample RQ calculation.

\[\text{DEF } K1 = 26.44\]
\[\text{DEF } K2 = 26.59\]
\[O2.v = 21 - NEO2.v\]
\[\text{DEF } CaR1 = (79.07*CO2.v/(100-O2.v-CO2.v) - 20.95)\]
\[\text{DEF } ObR1 = (20.95-79.07*O2.v/(100-O2.v-CO2.v))\]
\[\text{CER.v} = CaR1*\text{MASS FLOW.v}/\text{VOL.v} \times K2\]
\[\text{OUR.v} = ObR1*\text{MASS FLOW.v}/\text{VOL.v} \times K1\]
\[\text{RQ.v} = \text{CER.v}/\text{OUR.v}\]

### 5.14.9 RQ control of a dosing pump

RQ control of a dosing pump with automatic adjustment for increased volume.

\[\text{VOL.v} = \text{VOL.v} + (\text{DOSE.v}/1000)\]
\[\text{DEF } K1 = 26.44\]
\[\text{DEF } K2 = 26.59\]
\[O2.v = 21 - NEO2.v\]
\[\text{DEF } CaR1 = (79.07*CO2.v/(100-O2.v-CO2.v)-20.95)\]
\[\text{DEF } ObR1 = (20.95-79.07*O2.v/(100-O2.v-CO2.v))\]
\[\text{CER.v} = CaR1*\text{MASS FLOW.v}/\text{VOL.v} \times K2\]
\[\text{OUR.v} = ObR1*\text{MASS FLOW.v}/\text{VOL.v} \times K1\]
\[\text{RQ.v} = \text{CER.v}/\text{OUR.v}\]

\[\text{If}(\text{RQ.v} > 1.15)\{\text{Dose.sp} = (\text{Dose.sp} - 0.5)\}\]
\[\text{If}(\text{RQ.v} < 1.05)\{\text{Dose.sp} = (\text{Dose.sp} + 0.5)\}\]
\[\text{IF}(\text{Dose.sp} <= 0)\{\text{Dose.sp} = 0\}\]
5.15 Extra Control Language Sequences

ADDITIONAL SEQUENCES FROM INFORS UK LTD.

5.15.1 One-way control of PO2

#0
IF(pO2.v<80){RPM.sp=RPM.sp+50} ELSE{RPM.sp=200}
IF (RPM.sp>700){RPM.sp=690}

5.15.2 Using flow in a cascade control after rpm is at a maximum

#0
IF(pO2.v<35){RPM.sp=RPM.sp+50} ELSE{RPM.sp=200}
IF (RPM.sp>1500){RPM.sp=1490}
IF (pO2.v<35 AND RPM.sp>1480){Mass Flow.sp=Mass Flow.sp+0.1} ELSE {3.0}
IF (Mass Flow.sp>4.5){Mass Flow.sp=4.0}
IF (pO2.v>35 AND RPM.sp<1480){Mass Flow.sp=2}

5.15.3 SGM demo - simulation of effect on increasing Biomass on PO2 and stirrer

#0
DEF ET=ELAPSED*0.5; Biomass.v=(ELAPSED-ET)/60
pO2.bv=pO2.bv-(Biomass.v/2); RPM.bv=RPM.sp
IF(pO2.v<80){RPM.sp=RPM.sp+20} ELSE{RPM.sp=200}
IF (RPM.sp>700){RPM.sp=690}
IF (RPM.sp>650){SEQ=1}
#1 resets parameters to give sawtooth on RPM and pO2
pO2.bv=80
RPM.sp=200
SEQ=0

5.15.4 Control of bi-phasic feed linked to time of fermentation (equivalent to growth stage of culture)

#0 growth
if(time(0:5)<ELAPSED)AND(p02_43.v>50){seq=1}ELSE{seq=0}
#1 feed1
Feed1.sp=Feed1.sp+10
IF(Feed1*.sp>80){seq=3}else{seq=2}
#2 again
IF(seq_time>time(0:1)){seq=1} else{seq=2}
#3 feed2
Feed2.sp=(Feed2.sp+10)
Feed1.sp=0
feed2.sp= IF(time(0:25)<elapsed){feed2.sp=0}
Seq=4
#4 repeat
IF(seq_time>time(0:1)){seq=3}else{seq=4}
IF(Feed2.sp>60){Feed2.sp=70}else{Feed2.sp=Feed2.sp}
5.15.5 Fermentation simulation sequence

#0 Conditional Ramp (event driven)
RAMPC(RPM1,200,(pH1.bv>7.5),NEG(50))

#0 Modelling Using Backup Values
Temp.bv=Temp.sp
RPM.bv=RPM.sp
pH.bv=pH.sp
pO2.bv=pO2.sp
Mass Flow.bv=Mass Flow.sp

#0 SGM Simulation
Def ET=elapsed*0.5
Biomass.bv=(elapsed-ET)/60
Doxygen.bv=Doxygen.sp-(Biomass.bv/5)
Doxygen.bv=Doxygen.sp
RPM1.bv=RPM1.sp
IF(Doxygen.bv<80){RPM1.sp=RPM1.sp+20} ELSE{RPM1.sp=200}
IF (RPM1.sp>700){RPM1.sp=690}
IF (RPM1.sp>650){SEQ=1}
#1
Doxygen.sp=80
RPM1.sp=200
SEQ=0

#0 GROWTH
if(pO2.v>50){SEQ=1} else{SEQ=0}
#1 FEED
Feed1.sp=Feed1.sp+5
SEQ=0

5.15.6 Feeding according pO2

The flowrate and stirrer speed are at a constant rate.
The pO2 is regulated by the feeding. This can be used for "pichia pastoris" culture.

There are two sequences that do the control.

In the first seq the feeding rate (parameter name: "Feed_Pump") is increased by 1 if pO2 is higher than 35% and it is lowered by 1 if pO2 is smaller than 25%. Then it switches to the 2. seq.

The 2. seq waits for 5 min before it goes back to 1. seq. This is done to avoid to much changes of flow rate.
The Sequences:

#0,control
if(pO2.v > 35.0){Feed_Pump.sp=Feed_Pump.sp+1;Seq=1}
if(pO2.v < 25.0){Feed_Pump.sp=Feed_Pump.sp-1;Seq=1}

#1,wait_5
if(seq_time > time(00:05)){seq=0}
### 5.15.7 Pump Control sequences with detailed explanations

UNITEST2.SEQ contains the following sequences which will need modification before you can use them with your particular set-up.

**SEQ0: Growth**

```plaintext
0 if(time(4:10)<ELAPSED)AND(pO2_43.v>50){seq=1}else{seq=0}
```

**Explanation:**
The control sequence remains with the values defined in sequence 0 until the elapsed time exceed 4 hours 30 minutes (4:30) and the pO2 value is above 50% at this time (in case the change is late for some reason). When these conditions are met, control passes irreversibly to sequence 1. The curly braces {} mean THEN in the IRIS control language.

**SEQ1: Feed1**

```plaintext
0 Feed1.sp=Feed1.sp+10
1 if(feed1.sp>80){seq=3}else{seq=2}
```

**Explanation:**
After the criteria for change in sequence 0 are met, the pump Feed1 has its setpoint value incremented by 10 (equivalent to turning the pump on with a flow rate of 10%). The next line forces the control to pass to sequence 2 unless the setpoint value for Feed1 has exceeded 80%, in which case control passes to sequence 3.

**SEQ2: AGAIN**

```plaintext
0 if(seq_time>time(0:10)){seq=1}else{seq=2}
```

**Explanation:**
This is the "wait a bit" routine. If the time in the sequence is longer than the time set (0 hours:10 minutes in this case) then it goes back to sequence 1 to increment the flow rate of Feed1 otherwise it sits in sequence 2 "passing the time".

**SEQ3: Feed2**

```plaintext
0 Feed2.sp=Feed2.sp+10
1 Feed1.sp=0
2 if(time(6:0)<ELAPSED){feed2.sp=0}3 seq=4
```

**Explanation:**
This increments the flow rate of pump Feed2 in the same way as Feed1. Also, line 1 makes sure pump one is stopped as pump 2 "kicks in". The next sequence provides a waiting period between increments. This situation exists until the elapsed time is longer than 6 hours when it switches off Feed2. This assumes you want to do this. If not, simply remove this line and Feed2 will go on at a maximum flow rate you set in the next sequence.

**SEQ 4: REPEAT**

```plaintext
0 if(seq_time>time(0:10)){seq=3}else{seq=4}
1 if(Feed2.sp>60){feed2.sp=70}
```

**Explanation:**
Line 0 does the job of providing a waiting period between incrementing Feed2's setpoint. Line 1 provides a stop on the flow rate for Feed2.sp of 70%. Set the value from 70 to 100 and the pump will go at its maximum.
5.15.8 Additional Information about the Control Language

Sequences can have an unlimited numbers of DEF statements (for calculated variables which do not have to show in the parameter database) but defined variables CANNOT be passed from one sequence to another. They can, however, easily be re-defined in sequences where they are needed by using cut & paste.

Time-based ramps only work on time after inoculation, NOT duration time so it is vital to be aware of this and ensure the fermenter has been inoculated if a time-based ramp appears not to work. The \textit{time} function only converts elapsed time from seconds to hours and minutes - a ramp time value entered just as seconds eg.

\texttt{Ramp(ph,7.6,3600,120)}

will start a pH ramp to a value of 7.6 1 hour after inoculation for 2 minutes.

5.15.9. Global Variables.

These are special variables which allow information to be passed from one fermenter to another. They are of two types:

Variables

VAR1…VAR20 are used for transfer of floating point (real) numbers

Eg. Fermenter 1 has a control sequence set up as follows

\begin{verbatim}
SEQ0
VAR1=pO2.val  \text{(sets VAR1 to be the current value for dissolved oxygen)}
\end{verbatim}

On fermenter 2, a corresponding control sequence is set up to utilise the value transferred from fermenter 1

\begin{verbatim}
SEQ0
CALC.bv=VAR1
\end{verbatim}

sets the calculated parameter \texttt{CALC.bv} to be the dissolved oxygen value transferred from fermenter one as VAR1

In this example, a specific level of dissolved oxygen level in fermenter 1 could be used to effect a change in the operating conditions of fermenter 2 eg. a transfer valve opens.

Boolean Values

In addition to the transfer of variables, the Global variables of IRIS NT can be used to exchange Boolean values (eg. TRUE, FALSE, ON, OFF) and “countable” integer numbers. This option allows the status of one fermenter to influence the operating conditions of another.

Eg. Fermenter 1 has a Boolean operator set as follows:

\begin{verbatim}
SEQ0
BOOL1=5
\end{verbatim}
Fermenter 2 is set up to receive the value

\[
\text{SEQ 0} \\
\text{SEQ=BOOL1 (control passes to SEQ 5 on fermenter 2)}
\]

Global variables of either type are already declared within IRIS and can be used as required.

### 5.1.5.10 Debugger

#### Overview of Menu Structure and features

The debugger facilities built into the IRIS NT control language allow you to test your sequences step at a time following the automatic check for syntax errors. Anyone familiar with the debugger provided as part of the Microsoft Visual Basic® compiler will be completely at home with the IRIS system.

To access the debugger, use the main window menu options at the top of the screen and select the option **Debug**. A typical example of the debugger in use is shown below (Fig 5.8):

![Debugger Menu](image)

**Figure 5.8**

The **File** menu allows for opening a sequence, saving, save as & printing of a file.

The **Edit** menu is used for the standard cut copy and paste functions.

The **Window & Help** menu options are standard.

**Run** provides the opportunity to Compile or Run a sequence. A dialogue box always appears to ask if the changes to a sequence should be saved and if the sequence as shown is to be made active. A list box within the dialogue provides for selection of which sequence in the file is to be made active (defaults to zero).

**Debug** provides access to special features such as Go, Stop and Step for controlling progress through a control sequence.

The **Go** option starts the debugger and activates its specific screen display.
Breakpoint set/remove is concerned with halting the sequence at critical stages as defined by the user. Breakpoints are shown by small graphical "spots" which appear in the left-hand column beside the relevant line of code. From a breakpoint, further progress can be selected to be either step-wise or rapid. Stop debug changes the displayed window from debug mode to the normal edit mode.

Add Watch leads to a list box containing all the variables available to the debugger. These can be chosen to appear in the bottom section of the screen and their values observed as the sequence runs.

The window for the watch variables does not appear when the sequence is first loaded, a vertical window partition must be pulled upwards to allow it to show.

In operation, a blue arrow shows progress through the lines of sequence instructions. After a sequence has been executed once, the arrow does not appear to follow every line of instructions of the sequence is called again. This is an artifact of the debugger as, in reality, each line of code is evaluated every time the sequence is called.

Using the Debugger and Managing Control Sequences

The ability to create, edit or load control sequences are only available when an active fermentation is running. Depending upon how that fermentation has been started (i.e. is a control sequence selected at start-up or not) the compiler is accessed by using the Edit, Control sequence menu options followed by either:

- Edit current ... Allows changes to the sequence file already running
- Create new ... Allows creation of a completely new sequence file
- Load file ... Calls an existing sequence file for use or editing

The Load file option leads to a dialogue box asking if you wish to replace any currently active sequence file. Answer Yes, as the option to cancel is always provided in the Apply Sequence dialogue box.

When a sequence has been loaded into the compiler, the menu structure at the top of the active fermenter window changes to give the options outlines in section 5.6.1.

At this stage, the only option available in the debug sub-menu is go to start the debugging process.

Other sequence files can be loaded by using the open sequence option in the file menu. As the sequence files are simply test files at this stage, the normal cut, copy and paste functions are available from the edit menu. Sequences can be compiled and made active without the need to activate the debug functions.

For any sequence to be made available to the debugger, the sequence must be capable of being compiled and run as the active sequence. Any syntax errors which the compiler discovers must be dealt with before the debug function can be effective.

The sequence is "tested" at the point when the Apply Sequence dialogue box is displayed:

The answer to the question should be Yes for the debug function to be applied as it allows you to check in real time how the sequence is performing along side the de-bugging process.

Select the Go option (or use the F5 key) to start the debugger and the displayed screen changes from the edit to the debug mode. Use the mouse to drag the vertical bar at the bottom of the debug window to provide a screen area for any watched variable to be displayed. Columns labels of Variable and Value appear at the top of this vertical window.

Click on any lines of the sequence where you wish to place breaks and select the breakpoint add/rem option to toggle breakpoints on and off. The F9 key will also activate this feature. From a breakpoint, selecting Step from the Debug menu will allow the sequence to progress one instruction at a time. In step mode, an artifact of the compiler is that it does not look for which sequence to perform - this may effect the values given by some of the selected variables.
Selecting Go from a breakpoint will let the sequence file progress normally from that point.

Variables whose value you wish to monitor throughout the debug process are selected from a list of all possible variables using the Add watch menu option. A selected variable is added to the "watch window" using the Add button and variables can be selected in turn until the Close option is used. Selected variables can be removed from the list by right-clicking on a selected variable name in the "watch window" and using the remove option of the pop-up dialogue box.

As the sequence runs, a blue arrow moves down each line of sequence code to display progress. As the control passes from one sequence to another, the arrow moves accordingly. The "watch window" shows the current values of any variables displayed. At any time, the edit/debug screens can be toggled with both the alarm and active fermenter windows.

To edit the sequence file, use the stop option in the debug menu (or press the F10 key) and this allows a return to the normal edit screen.

When you are happy with the debugged sequence, it can be saved in its own right from the file menu or you can select Close from the main window menu. In edit mode, the Apply sequence dialogue box will ask if you wish to apply the modified sequence file.

5.18.11 Notes on Object Linking & Embedding (OLE) and IRIS NT Pro

IRIS NT Pro Network can be linked to external programs eg. the Excel spreadsheet, by using the OLE features of Windows 9x/NT. This section cannot be a tutorial in how to use programs such as Visual Basic for creating these links but the key features are described below for the benefit of experienced programmers. Be aware that if you use Visual Basic for Applications (which cannot produce stand-alone executable files) this application "hogs" all the processor resources and IRIS may not run properly. Overcome this by re-allocating resources manually.

Before using OLE link: IRIS must be running & the fermenter must be running

Create an OBJECT using the SET command

Eg SET WIRIS=OBJECT (WIRIS.CMD)

You MUST login first using a handle within IRIS. All "handles" are prefixed with H:

Eg. H=WIRIS.LOGIN 1admin.admin

Statements:

LOGIN

For Logging

GET PARAM.NAME
GET PARAM.VALUE

For control

SET PARAM.VALUE

Others

GET PARAM LA CA SP UA UC (Alarms or status)
SET PARAM LA CA SP UA UC (Ramps)
GET PARAM.VALUE STR (Value as a string)
CLOSEDOWN (no start equivalent as fermenter and IRIS must be running)
GET VERSION (or IRIS)
INOCULATE (Set in operation following waiting period after sterilization)
IS FERMENTER RUNNING? (Boolean, 1=True, 0=False)
IS PARAM AVAILABLE (Boolean)
LOGOUT
Every GET and SET needs:  H (handle) Ferm No.  Param No.

Returns a value as a double

SET VALUE needs H Ferm No.  Param No.  Value (double)

An example written in VBA within Excel 97 illustrates a simple data-display program using some of the features listed:

```vba
Attribute VB_Name = "VBiris1"
Dim iris As Object
Dim h As Integer
Dim i As Integer
Dim j As Integer
Dim startTime
Dim maxNum As Integer
Dim time As String
Dim getnameWiris As String
Dim getvalueWiris As String
Sub getnameandval()
Set wiris = CreateObject("Wiris.Cmd")  
h = wiris.Login("admin", "admin")  
ActiveCell.Value = wiris.GetParamName(h, ActiveCell.Offset(0, -2).Value, 
ActiveCell.Offset(0, -1).Value)  
ActiveCell.Offset(0, 1).Value = wiris.GetParamValue(h, ActiveCell.Offset(0, -2).Value, 
ActiveCell.Offset(0, -1).Value)
End Sub

Sub makeTab()
Set wiris = CreateObject("Wiris.Cmd")
h = wiris.Login("test", "testpaswd")  
ActiveCell.Offset(0, 0).Value = "Zeit"  
For i = 0 To 4 Step 1 'fill name of 5 parameters  
ActiveCell.Offset(0, 1).Value = wiris.GetParamName(h, 0, 1) '1. irisobject,  
fermener nr, Parameter nr
Next
startTime = Now
time = Now
For j = 1 To 15 Step 0 'after 15 data lines we stop
If time <= Now Then  
time = startTime + (j * TimeValue("0:00:05"))  
ActiveCell.Offset(j, 0).Value = Now  
For i = 1 To 5 Step 1 'fill 5 parameters  
ActiveCell.Offset(j, i).Value = wiris.GetParamValue(h, 0, i)
Next
j = j + 1  
'Application.Wait (time)
End If
Next
End Sub

Sub fillNumber(v As Integer)
maxNum = v
End Sub

Please note that we will be happy to provide information made available to us about OLE links created by our users but we do not provide specific help on developing Visual Basic applications.
6 FOLLOW FILE

How do I use Follow File

This is a very useful way to get a series of experiments running with maximum reproducibility but the minimum of programming. It allows a new fermentation to mimic an archived file by having set-point values created from the data points of the archived file. Therefore, a high degree of automation of a process can be achieved without needing to know anything about the IRIS control language.

The option to use Follow file is presented as part of the sequence of dialogue boxes used to start a fermentation (see section 3.1.2). A file to follow can be typed in the text edit box in the relevant part of the dialogue box or the Browse button used to activate a file selection window.

In outline, once a file is selected, a pair of windows open showing the parameters available from the archive file in the left-hand window and those selected for the current fermentation in the right hand. Parameters “for following” and “being followed” are paired as so:

However, not all parameters have to be followed, one or more can be switched to "manual" control or be influenced by the control language. Follow file can be switched on or off from within Sequences to give a kind of "cruise control" i.e. go onto automatic until "X" happens...

To duplicate the data from one fermentation into another we use the ‘FOLLOW FILE’ facility. At setup, the user selects follow file. The steps after this are outlined below.

1. Select the previous fermentation file from the file selection window which opens.

2. Select matching parameters as shown below from the dialogue box which opens to show two columns with "real" and "followed" parameters provisionally assigned to each other.

3. Double click on a parameter name to alter the assignment using the selection dialogue which is activated.

4. Start the fermentation by pressing the FINISH radio button.

Now only those parameters selected will have their setpoints set from the previous fermentations values.
The possibility to use Follow File for taking a fermentation to a certain stage of growth on “automatic” before implementing control sequences has already been mentioned. Also, for repetitive work, a “definitive” fermentation can be chosen and used as a “template” many times over for production applications.

When used with multiple fermenters, such as the Sixfors and Vario, Follow File saves time in setting up experiments where all parameters are held the same except one which varies for each vessel in the group eg. 6 different pH=s are used.
6.1 Follow File Generator for Time-based Profiling

This is a new option in the File.. Open menu. It allows a time-based profile to be defined as a series of steps which is saved and subsequently selected as the "follow file" option for a new fermentation.

Initially, you must first select which fermenter the profile will be applied to and then the parameters to be used. This is identical to manual selection for the setup of a fermentation. After the parameters have been selected, the main screen is shown which is essentially the same as that for the new on-line graphical display:

Clicking the Table button will bring up a new window which allows set points for the chosen parameters to be entered. Each parameter will have its own table and they are filled in one at a time.

Entry of setpoints is exactly the same as the method used for entry of off-line analysis data (which, of course, is exactly what it is).

The parameters are selected from a drop down box in the "Edit Trace" window or by double clicking on the axis for the chosen parameter on the graphical display. Extra parameters can be added using the "Fermenter" option in the main menu.

The line for the currently chosen parameter is emphasised by being thicker.

The best approach is to first enter the values for the start time and end time. This defines the time base for the graph. Time is entered in a 00days: 00:00:00 Hours: Minutes: Seconds format and the required setpoint value is then entered in the "Value" box below. Click "Apply" and the information moves to the text area above the data entry section. Add intermediate points and they are automatically inserted into the correct place in the table and the profile is built up. Click "close".

Once the basic profile is created, it can be edited directly on the graph using an additional set of buttons:
Using the **Edit Points** button will allow the entered setpoint values to be shown as spots on the line for the chosen parameter. These can then be "picked up" by the cursor and dragged to any new position required to change the shape of the graph.

The parameter selected can be changed by double clicking on the name of the parameter on the Y axis of the graph. The currently selected parameter has the name **underlined**.

The finished graph is saved with the desired file name and is stored as a normal .iri file which can then be selected when starting a fermentation by entering its name in the "follow file" box.
7. User log.

This window is primarily for information about user actions and it allows a complete record to be built up of what was done, by whom and when each event happened. Right clicking on the display brings up a small dialogue box to allow saving of the current information as an archived text file which is in a text format and therefore easy to access. Events which may require review by a supervisor are marked with an exclamation!

Why is this important?

The American FDA have created legislation relating to Electronic Records and Electronic Signatures which profoundly effect the use of SCADA (Supervisory Control And Data Acquisition) software and its associated data record files within the Pharmaceutical industry. Their objective is to make sure that those records relating to pharmaceutical products manufactured using SCADA systems are completely verifiable in terms of accuracy & freedom from tampering, also ensuring that they are authorized by a suitable person with a traceable signature.

The FDA describe controls in 21 CFR Part 11 to achieve this objective and the User log is part of the systems Infors provides to address these regulations. For a detailed description, please see our specific documentation relating to Part 11 (available on request)
# 8 TROUBLESHOOTING

## 8.1 Overview

<table>
<thead>
<tr>
<th>FAULT</th>
<th>DIAGNOSIS</th>
<th>REMEDY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program will not load following installation</td>
<td>Incorrect installation</td>
<td>re-install (Standard) - especially if a custom installation was chosen and some parts were unselected.</td>
</tr>
<tr>
<td>Program will not load after working OK for some time</td>
<td>Vital files not in same subdirectory or path to these files not given.</td>
<td>Unless it really is necessary, do NOT alter the default setting in EXTRAS - SPECIAL FEATURES Iris system directory path i.e. leave blank!</td>
</tr>
<tr>
<td>IRIS starts, but you are unable to access any features as default user</td>
<td>Default user has no rights</td>
<td>Log in again as admin. (Password is admin). Change access level for default user if this has been reset to zero to any realistic number up to 255. Iris system directory path is wrong try to delete Iris.ini (found in `Window system\A directory), Set Iris data (working) path back to Iris system path. Reinstall these files to Iris directory.</td>
</tr>
<tr>
<td></td>
<td>Levels.p, Wiris.ups and Wiris.rgt are not found</td>
<td>Corruption of levels.p, Wiris.ups and Wiris.rgt file or deliberate attempt to keep you from access</td>
</tr>
<tr>
<td>FAULT</td>
<td>DIAGNOSIS</td>
<td>REMEDY</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>No Data-logging or control</td>
<td>Cable not connected</td>
<td>Connect firmly at both ends</td>
</tr>
<tr>
<td></td>
<td>Cable connected to wrong COM port</td>
<td>Check which COM port a fermenter is assigned to and swop if needed.</td>
</tr>
<tr>
<td></td>
<td>Cable connected to wrong fermenter</td>
<td>Swop cable if necessary.</td>
</tr>
<tr>
<td></td>
<td>Cable not earthed at one end</td>
<td>Ensure earth strap connected at the computer end to a case screw</td>
</tr>
<tr>
<td></td>
<td>Fermenter not switched to remote operation</td>
<td>Select this option at the Fermenter instrumentation.</td>
</tr>
<tr>
<td></td>
<td>COM port settings incorrect</td>
<td>Check in Peripherals dialogue box (Extras, menu, devices sub-menu)</td>
</tr>
<tr>
<td></td>
<td>Fermenter mis-assigned</td>
<td>Check in Fermenter Properties dialogue box.</td>
</tr>
<tr>
<td></td>
<td>Device model incorrect eg. set for ISF not S-DDC</td>
<td>Click on Settings button in Peripherals dialogue box and check settings re. fermenter manual.</td>
</tr>
<tr>
<td></td>
<td>Wrong protocol for comms. Eg. baud rate or parity mis-set.</td>
<td>Ensure the fermenter COM port is not shared - check Control Panel settings in Windows</td>
</tr>
<tr>
<td></td>
<td>Conflict with other devices on COM port eg. a mouse</td>
<td></td>
</tr>
<tr>
<td>Error opening comm port</td>
<td>COM port settings incorrect</td>
<td>Check in Peripherals dialogue box (Extras, menu, devices sub-menu)</td>
</tr>
<tr>
<td>Message-box apears</td>
<td>COM port not existing on this computer</td>
<td>Try different commport</td>
</tr>
<tr>
<td></td>
<td>Conflict with other devices on COM port eg. a mouse</td>
<td>Ensure the fermenter COM port is not shared - check Control Panel settings in Windows</td>
</tr>
<tr>
<td>Logging but no Control</td>
<td>Parameter not set for this</td>
<td>Click remote operation ON in the Edit Measured Parameter dialogue.</td>
</tr>
<tr>
<td></td>
<td>Fermenter settings are not correct</td>
<td>Set accept remote on on the fermenter control panel.</td>
</tr>
<tr>
<td>No change in logged value</td>
<td>Backup value may be ON - look in Text view table</td>
<td>Click backup value OFF in the Edit Measured Parameters dialogue</td>
</tr>
</tbody>
</table>
9 APPENDICES

9.1 Brief Guide to the Windows features used in IRIS NT

This manual cannot provide a full tutorial and reference work for the use of Windows 9x and NTx. Many excellent books, videos and training courses already exist to meet that need. However, a number of terms have been used in the text to describe various parts of the IRIS program relating to the component parts of Windows. This brief section offers simple explanations and definitions for clarity.
9.1.1 Properties of Active Windows.

This is a map of a typical window which indicates various features described throughout the text so you can locate them. Not all windows have all of these features, depending upon their function.
9.1.2 Dialogue Boxes.

If the IRIS window provides access to the main Menu and Toolbar options, the dialogue box is what is almost always activated by a menu or button selection. It is in these screens that the detailed choices are made in the configuration of IRIS.

Text Edit Box for entering values and all types of alpha-numeric data.

Tick Box for making ON/OFF choices. Clicking in the makes/removes the tick.

Drop Down List. A text edit box with a button on the right hand side. Click on this box to reveal a list of options from which to make a choice of one. If you type your selection this will not be accepted

OK button for confirming alterations and exiting the dialogue box.

Cancel for aborting changes and leaving the dialogue box.

(An Apply button may sometimes be present to confirm an alteration but leave you in the dialogue box to make other changes.)

Some dialogue boxes take the form of small windows or lists from which to make choices.

9.1.3 Drop Down Lists (Combo Box).

These have been described in section 9.2. An important additional point to note is that the choices given invariably cover all the possible options of that choice i.e. you cannot enter text to make up a totally new choice.

9.1.4 Radio Buttons

These are found in just a few of the IRIS dialogue boxes. They look a little like the push buttons found on car radios, hence the name. They allow selection from a number of mutually-exclusive options where only one choice can be active at once e.g. for Rectangle style it clearly cannot have both round and angled corners at the same time.
9.1.5 Keyboard Shortcuts and Menu Options

Many of the common actions such as printing or saving a file can be accessed by means of pressing a combination of keys in addition to menu options and toolbar buttons.

Ctrl + S = Save
Ctrl + O = Open
Ctrl + N = New File
Ctrl + P = Print
Ctrl + X = Cut
Ctrl + C = Copy
Ctrl + V = Paste
Ctrl + Z = Undo
F1 = Help

Use Alt + the underlined letter of a menu option to open it e.g. Alt + F opens the File menu

A menu option which has either “...” After it leads to a dialogue box with additional choices.

A menu option with a ∋ symbol means that sub-menu are available by moving the cursor to the right.

9.2 Request a file by FTP

To use this facility, the data files MUST be on a network server enabled for FTP file transfer as part of the TCP/IP network protocols. This cannot be a computer with any fermenters are attached.

The FTP dialogue box (Figure 9.1) is activated from the File menu of the History Viewer and the information required will be known by anyone familiar with FTP file transfer. An explanation of this protocol is not within the scope of this manual.
9.3 Send a File by e-mail

The simplest way is to use your existing e-mail program eg. Microsoft Internet Mail, Messenger, Pegasus, Eudora etc. and include the FILENAME.iri file as an extension.

Alternatively, a report can be prepared and saved as a text file to send data without the need for the IRIS History Viewer.

Graphics can be converted to FILENAME.emf or .bmp files for sending to colleagues without the IRIS History Viewer.

9.4 IRIS Applets

IRIS version 5 has some additional programs to help with storing and modifying configuration data.

Memcard.exe

This helps with uploading and downloading information from the memory card in the DDC controller to files on a computer.

The serial COM port to be used can be configured and the only decision is then which type of operation is required;

a) Downloading information from a memory card.

b) Uploading information to a memory card.

The next stage is to find the location for these files file and/or provide a new filename for a download.

This uses a standard windows dialogue box.

The advantage of this system is that many different configurations for a fermenter can be stored for use with one one memory card. It also provides insurance against configuration data being lost if the memory card battery fails.
Fermenter Parameter Edit

This is a new utility providing a means of storing and editing some configuration data associate with parameters on a computer rather than at the fermenter. It also provides a means of archiving this data. It is intended for fermenters which use S-DDC only (Techfors).

The opening menu uses tabs, similar in structure to the colour Touchfors display for S-DDC. A basic set of options is provided with the opportunity to access advanced features for service and configuration beyond normal, everyday requirements.

The standard options are:

- **Select**: for choosing the desired parameter from a list of available options.
- **Setpoint**: for entering set points and alarm limits
- **PID setup**: for altering how the controller output behaves in response to a deviation from set point by the actual value
- **Calibration**: One or two points used to relate real analogue values to the analogue to digital equivalents
- **Name**: to label a parameter

The Advanced setting shows the following additional options (do NOT use these unless you understand the likely effect of any changes)

- **Output Settings**: This screen lets you define how a parameter output is set up in terms of type of control, display of pumps, etc.
- **Output Limits**: Allows you to set minimum and maximum outputs plus define a ramped output.
- **Cascade**: For using the output from one parameter eg. flow to control another eg. pO₂ in a pre-defined succession.

When in Advanced menu, a pair of arrows to the right of the tabs are used to scroll sideways to tabs which are not visible.

The **File** Menu offers the standard options plus **Export**, which allows the data to be output as a text file. This is of value for archive and documentation purposes.

The **View** Menu allows display of the toolbar plus status bar and is used for access to the Advanced menu options.
10 Glossary of Terms

**Analogue Box**
This electronical tool is for measuring external signals and bring the values into the Iris system. External, analog pumps can be connected to a analog box.

**batch ticket**
This is a section where the user can make comments to the running fermentation. This information can be printed seperately or in a text report.

**satelites**
A satelite of a Labfors is a Labfors fermenter that does not have a display. All information is given to a Master Labfors. The user can remote control a satelite with the master unit.

**serial port**
A serial port is also known as RS232. Most PC's have at least one of these ports with either a 9 or 25 pin socket.

**switch box**
A electronical device to connect more than one fermenter or balance to one serial port. The software sends codes to select the channel.
**11 Index**

Aaxis, 11–12, 61, 63–64, 69
Access, 5, 15, 19, 20–22, 31–33, 34–36, 38, 40, 60, 103, 107–8
ADJUST, 11, 64, 80, 84, 86
Analogue Box, 17
Analysis Parameter, 10, 25, 54, 56
ASSERT, 80, 86
Averaging, 13, 68
Batch, 5–7, 13, 19, 20–22, 31–33, 34–36, 38, 40, 60, 103, 107–8
Baud Rate, 37, 55, 104
Calculated, 5, 6, 8, 20, 25, 29, 44, 68, 74, 83, 88
Calibration, 8, 25, 27, 30–31, 36–37, 36–37, 88
Closedown, 7, 32, 36, 41, 52, 57
Closing, 57
Com Port, 16, 37, 55, 104
Communication, 5, 16, 21, 32, 37, 42, 44, 54
Comparison, 5, 11, 58, 60, 64, 68
Control Sequence, 6, 13, 15, 24, 40, 52, 74, 92
Correlation, 5, 20, 58, 69–70, 72
Critical, 21, 28, 35, 44, 50–51, 50–51, 55–56, 80, 83, 86
DEF, 31, 80, 86, 89, 91
Default Title, 32
Difference, 25, 27, 66, 87–88, 87–88
Evaluation Time, 74
EXP, 79–80, 79–80, 86, 89
Extras, 16, 21, 37–38, 37–38, 54, 103–4, 103–4
Filtering, 27
Follow File, 5–6, 14, 24, 98–100, 98–100
Forget, 34, 38
FTP, 58–60, 58–60, 108
Grid, 11, 41, 61, 71
Inoculation, 4, 6–7, 23, 33, 41–42, 41, 42, 56, 63–64, 63–64, 68, 80
Labfors, 6, 17–18, 17–18, 21–23, 21–23, 31, 37, 73
LIMITS, 5, 7, 8, 28–29, 28–29, 41, 51, 63, 73, 80, 83, 85–86, 85–86
LN, 79, 86, 88
Log Rate, 15, 27, 87
Marker, 11–12, 11–12, 61, 64–67, 64–67, 70
Measured, 5, 6, 8, 18, 20, 25–26, 25–26, 28–29, 28–29, 44, 45, 54, 68, 104
Parity, 21, 38, 104
Password, 5, 21, 33–35, 33, 35, 38, 42, 62, 103
Priority, 78
Pump, 5, 6, 8, 18, 25, 27, 29, 38, 85, 89, 91–92, 91–92
Quick Edit, 9, 30, 44–48, 44–48, 51, 73
RAMP, 80, 81–82, 81–82, 86, 90
RAMPC, 80, 81, 86, 91
Report, 5, 10, 13, 15, 26, 28, 39, 52, 55, 58, 60, 68, 109
Reports, 10, 26, 28, 52, 55, 58, 60, 68
Request, 54, 108
Schema, 9, 31, 40, 42, 49–50, 49–50
Select Mask, 26, 31–32, 31–32
Seq Name, 74
SEQ_TIME, 80, 90–91, 90–92
Sixfors, 17–18, 17–18, 23, 73, 99
Spike Rejection, 27
Sterilization, 5, 6, 19, 23, 31–33, 31–33, 41, 52–53, 52
TIME, 5, 6, 11–12, 13, 16, 18, 23, 27–28, 27–28, 
31–33, 31–33, 38–39, 38–39, 42, 56–58, 
61, 63–68, 63–68, 73–80, 73–80, 82–83, 
103, 99–103, 107 
Time Outs, 54 
Toolbar, 9, 11, 12, 16, 20, 22, 25, 33, 40–42, 
40–42, 44, 40–42, 50, 52, 59–61, 59–61, 
Value Button, 11–12 
Zoom, 9, 11, 41–42, 41–42, 50, 61, 63, 71